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Overview 

TradeTek currently includes 64-bit Windows and 64-bit Mac versions that are designed to take advantage of the 
latest advances in technology.  Utilizing multi-threading technology, this software’s performance and processing 
speed increases with the use of faster, multi-core processors.  While standard and HD displays are supported, 
the application is optimized for 4K, and Retina displays which help reduce eye fatigue when long days of 
estimating are required. 

Developed from nearly 60 years of construction industry and software engineering experience combined, every 
detail has been carefully considered to ensure that the user experience is second to none.  Designed to include 
all the robust features that today’s construction professionals need in a takeoff and estimating software package 
while ensuring that 100% of the application is as easy to use as possible truly makes this a unique and cutting-
edge solution. 
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Let’s take a quick look at where things are located within the software (we’ll get into more detail later). The 
following is a summary of the contents of each main tab in the application: 

− Home Tab: The Home tab contains the Job, Navigate, Dimension, Takeoff and Markup button groups.  
The main page area in this tab is typically where most of your takeoff will be performed. There are 2 side 
panels in this tab to the left and right of the main page area. 

− Page Tab: The Page tab contains the Zoom/Pan, Rotate, Flip and Image Tool button groups.  This tab 
also contains the main page area and 2 side panels. 

− Tool Tab: The Tool tab contains the Takeoff Item and Calculation button groups and contains the main 
page area and 2 side panels. 

− Estimating Tab: The Estimating tab contains the Estimate, Clipboard and Adjust button groups.  This tab 
also contains all takeoff items for the open job and displays the information with property columns that 
are determined by the selected estimating layout in the left side panel.  The right side panel can display 
either Pages, Estimating or Templates. 

− List Tab: The List tab contains the List and Move/Update button groups.  All list files are displayed in the 
left side panel and the main area displays the selected list. 

− Template Tab: The Template tab contains the Template Tools, Clipboard, New Assembly and Adjust 
button groups.  The main are contains the Set Default Properties tab, Sample Assemblies tab and all 
other user added templates tabs.  The right-side panel will display either Pages, Estimating or 
Templates. 

− Report Tab: The Report tab contains the Report Actions button group.  The main area displays either 
the Preview or Build tab of the selected report.  The left side panel displays all sample and user added 
report files.  The right-side panel contains all of the report tools used for building reports. 

− Help Tab: The Help tab is where you can access the User’s Guide, videos and report bugs or request new 
features. 

License Management 

To access the License dialog, click File at the top left corner of the window then click About TradeTek.  Next, 
click the License button at the bottom left corner.  To look up your activation serial number, click the Lookup 
Serial Number button then enter the email address associated with your account.  To view your activation data 
or to release or restore a license, click the License Options button.  To manage all of your TradeTek licenses, 
click the License Management button.  In the top left corner of the License Management dialog, click on a 
license name to view all activity for the license in the area below.  To add a new serial number to the License 
Management dialog, click the Add button and then enter the license name and serial number.  To edit a licenses 
name or serial number, click on the license name to select it, then click the Edit button.  To delete a license from 
the License Management dialog, click on the license name to select it, then click the Delete button.  The total 
number of allowed activations for your account is displayed to the right of the OK button.  Click the Info For This 
Computer button for information to help identify this computer from the activity list.  Click the Bundles This 
Computer button to view all bundles that are licensed or available to this computer.  To dismiss the dialog, click 
the OK button. 

Preferences 

To access the preferences dialog, click File at the top left corner of the window and click Preference from the 
drop-down menu.  The Preference dialog allows you to set the following preferences that will be applied each 
time that you use the application:  
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− If the Retain Window Size and Position on Open checkbox is checked then the main application window 
size and position will be saved from the last time that you used the application and will be restored 
upon next launch.  If not checked, the app window will open to maximized. 

− Toggle the mouse wheel zooming capability on or off with the Mouse Wheel Controls Zoom checkbox. 
− To set the application to auto save check the Auto Save Changes check box then choose the interval in 

minutes from the drop down menu.  To manually save changes, Click File and then Save from the drop-
down menu. 

− To automatically save changes on close, check the Save On Close Without Asking checkbox.  Otherwise, 
you will be asked each time you close the application if you want to save your changes or not. 

− By default, the Help tab videos will play inside of the application.  If you are using 4K monitors the 
videos and controls may appear smaller than normal.  If this occurs, check the Play Videos in Default 
Web Browser check box to launch the Help videos into a separate web browser window.  You may also 
want to launch videos into a browser window to be able to move them around. 

− When the Set Qty 0 For Off SubItems check box is checked, all assembly sub-items that are turned off 
by checking the Off check box will have a quantity value of 0. 

− When the Wide Assembly Dialogs checkbox is checked, all assembly dialogs will be wider making it 
easier to read item names with longer names. 

− With some older computers, TradeTek page performance such as the cursor guidelines, page zooming 
and page panning may experience a lag.  If this is the case, check the Slow Graphics Compatible check 
box which may help improve performance on older computers. 

− The Username edit field by default contains the username that the application has obtained from your 
computer.  You can change your username here in the Preference dialog.  If multiple users have access 
to your job files, your username will be used to identify to them when you are actively working in the 
file. 

− By default, TradeTek is in imperial measurement mode. To switch to metric mode, check the Metric 
check box.  The settings and properties for the takeoff tools in the Set Default Properties, new 
assemblies that are created and added to assembly groups and new jobs that are created are all set 
based on the current measurement mode.  When a job is opened, TradeTek automatically toggles the 
measurement mode to match the mode that the software was in when the job was created. 

− If the Cursor Gridline Color check box is checked, a horizontal and vertical gridline will be visible 
extending from the page area cursor in the Home and Page tabs.  To change the gridline color, click the 
color box and choose a new color. 

− The OK Cancel Button Order radio buttons allow you to set the default order of these buttons in the 
dialogs to either the Windows standard or Mac standard order. 

− Lists of items in multiple areas of TradeTek can optionally be alphabetized.  Set the desired mode by 
selecting on of the Alphabetic Sort Order radio button options. 

− By default, you will occasionally receive notifications from TradeTek Software on launch.  To turn these 
notifications off, uncheck the Notifications check box.  To view a list of recent notifications, click the 
Show Notifications button. 

− To activate the Developer tab and developer help videos, check the Developer check box.  The 
Developer tab gives you access to the API sandbox and allows you to create plugins. 

− To turn the application desktop API on, check the API checkbox.  Otherwise, the desktop API is not 
accessible. 

− To turn the application cloud API on, check the Cloud API checkbox.  Otherwise, the cloud API is not 
accessible. 

− If your internet connection is slow, check the Allow Slow Internet checkbox.  This will allow functions 
that require the internet to not time out as quickly. 
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− Check the Experimental AI check box to activate experimental AI features.  When checked, a dialog is 
presented with more information including the features that are included in the current build. 

− The Separate CSV Columns radio button selection determines the format of exported CSV report files.  
Comma is the most common format and is the default selection. 

− The Images in Excel Workbook radio button selection determines if images that are included in 
exported excel reports are embedded in the excel file or are linked in the file to an image stored on your 
computer.  The default selection is Embedded.  In very large reports with multiple images, if 
performance is an issue, then select the Links option prior to exporting. 

− In the Report Resolution drop-down menu, choose either Good, Better, or Best resolution.  This will 
typically need to be determined based on the resolution of your monitor.  For example, with standard 
resolution monitors if Best is selected, the report likely will not display properly.  If you have a 4K 
resolution monitor, then Best will provide the best possible report resolution.  You can customize the 
way the exported reports are named by typing in a name in the Export Name field, or setting the desired 
Job, Report or Date check boxes to construct a naming convention.  To name the report differently each 
time it is exported, set the Ask Me check box. 

− In the Resolution drop-down menu, choose either Good, Better, or Best resolution for screenshot 
images.  Older computers may take longer to generate larger page size screenshots in certain file types.  
Downgrade the resolution to help screenshots process faster. 

− Pattern images are used by markup tools to paint the surface of a shape or draw images on the page.  
Default images are included during installation.  Click the Default Patterns button to restore the original 
images or to merge the default images to images that you have added. 

− Click the Keyboard Shortcuts button to assign shortcuts to various functions within TradeTek. 
− To manually set the name of the report file that gets exported from TradeTek, type the desired name in 

the Export Name edit field.  Additionally, you can also construct the name of the exported report by 
setting the appropriate Job (name), Report (name) and Date checkboxes for the values that you want 
included in the report file name. 

− If you have a large number of assemblies, there are several areas in the software that must scan through 
all of the assemblies to generate property lists which can take some time to process.  To optimize this, 
set the Cache Template Property Lists checkbox.  This will store a cache of all existing properties so that 
the software does not have to re-scan constantly.  If you add new properties to assemblies, in order for 
them to become available in the calculation formula drop-down lists you will need to click the Clear 
Cache button then generate the new cache. 

− Adjust the page legend transparency by selecting from the Legend Dim Color drop-down menu and 
adjust the background color by selecting from the drop-down menu. 

− Adjust the page transparency by selecting from the Page Dim Color drop-down menu and adjust the 
page color by selecting from the drop-down menu. 

− The Export button allows you to export all your preferences including all the settings in the Preference 
dialog, all custom estimating layouts from the Estimating tab, all lists that have been added in the List 
tab, all assembly groups that have been added in the Template tab and all reports that have been 
created in the Report tab.  The exported file can then be imported by another computer.  You can also 
export these individually from their perspective tabs. 

− The Import button allows you to import a preference file that has been exported from another 
computer. 

− The Show button opens to the folder location where the preference file is stored. 
− The Backup button saves a copy of the current preferences on the local computer. 
− The Restore button restores the preferences from the most recent backup. 



11 | P a g e  
 

− Click the Admin Protection button to set restrictions on what regular users can access in TradeTek.  As 
an Admin user, enter a password.  To turn protection on, click the Protection ON button (this must be 
done on all computers in the organization).  To login as an Admin user, click the Admin Login button.  To 
set the restrictions for regular users, click the Restrictions button and set the appropriate check boxes 
for areas to restrict.  If you are creating a private or 3rd party bundle, click the Register Bundle button to 
register the bundle information with TradeTek Software so that a meaningful message can be displayed 
to the user when attempting to use an unlicensed bundle.  Once protections have been setup on the 
Admin user’s computer, those settings can be shared with regular users either by exporting the Admin 
user’s preference file and then importing into the regular user computers or by creating a bundle (items 
that are added to bundles will retain all protection settings.  User added properties in assemblies can be 
individually locked by clicking the lock icon in the Edit Property dialog.  To lock or unlock all properties at 
once, hold down the Shift key while clicking the lock icon of one of the properties.  This feature is only 
available when logged in as Admin. 

Saving Changes 

You can manually save changes at any point by clicking File at the top left corner of the application window and 
click Save from the drop-down menu.  To set the application to automatically save changes every 5 minutes click 
File, click Preference from the drop-down menu and check the Auto Save Changes Every 5 Minutes checkbox.  
To set the application to save changes on close without asking, check the Save On Close Without Asking 
checkbox.  Otherwise, you will be asked each time you close if you would like to save changes or not. 

Properties 

Takeoff tools, assemblies, assembly sub-items and Estimating tab folders can all include both default properties 
(non-user added) and user added properties.  The 4 available property types are Text, Number, Color & Image.  
Text and Number properties include value formulas that allow you to reference other values of the same type 
from anywhere within its “family tree”.  A “family tree” includes any user added job properties along with an 
item and all its sub-items.  For example, an assembly with multiple sub-items located within a folder in the 
Estimating tab would be an example of a “family tree”.  In this scenario, a user added text property in an 
assembly sub-item could reference other text properties located in other assembly sub-items, the assembly 
itself and the folder containing the assembly (same goes for number properties).  

Dot notation is used to access properties contained within other items.  To access properties in takeoff tools or 
assemblies use [Item Name.Property Name].  To access properties in assembly sub-items, use [Sub-Item Tab 
Name.Property Name].  Properties that have been added to Estimating tab folders can be accessed in nested 
folders up to 3 levels deep.  To access a property in a folder 1 level up use [Folder.Property Name].  To access a 
property in a folder 2 levels up use [FolderUp1.Property Name] and to access a property in a folder 3 levels up 
use [FolderUp2.Property Name].  Properties can be added to Estimating tab folders in the Template tab -> Set 
Default Property tab and then referenced from assemblies in the Assembly Group tab.  Properties must be 
added to the folder in the Set Default Property tab before they become available in the drop-down lists in the 
formula editors. 

− Text Properties: With default text properties that already exist within the takeoff tools, assemblies, 
assembly sub-items and Estimating tab folders you will typically only be providing a value.  For example, 
when you add a folder to the Estimating tab, you are prompted to provide a value for the Name 
property.  When you add a custom text property to something you will input the name of the property 
and will construct the value in the Text field by either entering text, selecting the value of another 
existing text property or the combination of both.  To select the value of another existing text property, 
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choose that property from the Select Property drop down menu.  To construct a value from a 
combination of an existing text property and text, simply select the desired existing property from the 
list and add the additional text before or after the existing property in the Text field.  For example, if you 
wanted to add an existing property called “First Name” and then add the last name with text this is what 
it would look like in the ”Text” field: [First Name] Smith.  If the property “First Name” had a value of 
“John” then the value of this property would be “John Smith”.  Text properties can also be connected to 
a single column list created in the List tab that allows you to choose the value from that list. 
 

− Add a Text Property: In the Edit Text Property dialog, type the name of the property in the Name input 
and type the property value or formula in the Text area.  You can optionally connect the property result 
to a single column list in the List tab by clicking the Connect To List button at the bottom left corner of 
the Edit Text Property dialog and following the prompts.  Click the OK button to add the text property.  
When the property is added, it will become visible in its parent dialog.  To edit or delete the property, 
click the … button at the far-right side of the property. 

− Number Properties: With number properties you will be providing the property name, quantity value or 
formula and the result format.  The available result formats are 0, 0.0, 0.00, 0.000, 0.0000, 0.00000, 
0.000000, Feet to Inches, Inches to Feet, Round Up, Round Down, Feet / Inches, Inches.  The following is 
a description of how some of the non-obvious format’s work: 

o Feet to Inches: Converts the input value from feet to inches.  For example, if the result value is 1 
the converted value will be 12. 

o Inches to Feet: Converts the input value from inches to feet.  For example, if the result value is 
12 the converted value will be 1. 

o Round Up: Rounds up the value to the nearest whole number. 
o Round Down: Rounds down the value to the nearest whole number. 
o Feet / Inches: Displays the value in feet and inches format.  For example, if the result value is 

10.125 the converted value will be 10’ 1 ½”.  This format is for display purposes only and cannot 
be used as an operand in a formula. 

o Inches: Displays the value in inches format.  For example, if the result value is 10.125 the 
converted value will be 121 ½”.  This format is for display purposes only and cannot be used as 
an operand in a formula. 

To edit the Qty Formula in the Edit Number Property dialog click the … button at the far right to launch 
the Formula Editor dialog.  You will notice above the text area the available formula operator buttons.  
Clicking one of these buttons will insert the operator at the cursor location.  To the right of the operator 
buttons is the operand drop down list with Select Property displayed that provides all the available 
number properties within the “family tree”.  Clicking on one of these properties in the list will add it as 
an operand in the formula at the cursor location.  You can create formulas that contain a combination of 
number properties, operators, and literal numbers (numbers that you type into the equation).  Formulas 
will execute from left to right and anything inside of “()” operators will execute before continuing to the 
right.  For example, let’s say that we have created a linear wall assembly called “Wall Assembly” and we 
have added a sub-item to the assembly and named the sub-item tab “Studs”.  In the Studs sub-item, we 
have added a number property called “OC Spacing” with a value of “16” and a format of “Inches to Feet” 
and another number property called “Waste” with a value of “10” to represent 10% waste.  In the 
“Quantity” property of the Studs sub-item we need to write a formula to calculate the number of studs 
needed in the wall based on the required stud on center spacing.  To do this, we need to take the total 
linear feet of the takeoff measurement (we do this by grabbing the “Linear” property of the “Wall 
Assembly”), divide it by the stud on center spacing and then add a waste factor.  Here’s an example of 
what the formula might look like in the Formula Editor:  
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[Wall Assembly.Linear] / [Studs.OC Spacing] * ([Studs.Waste] /100 + 1) 
If the entered formula is working, the result shown in the bottom left corner of the Formula Editor 
dialog should be a valid number.  If there is a problem with the formula, the result should display an 
error message. 

− Add a Number Property: In the Edit Number Property dialog, type the name of the property in the 
Name input.  In the Qty Formula input, you can either type in a number for the value or click the … at 
far-right to open the Formula Editor and add a calculation formula.  In the Format drop down, choose 
the desired value format.  Click the OK button to add the number property.  When the property is 
added, it will become visible in its parent dialog.  To edit or delete the property, click the … button at the 
far-right side of the property. 

− Add a Color property: In the Edit Color Property dialog, type the name of the color property in the 
Name input.  Click into the color box to display a color wheel and click into the color wheel to choose 
the color.  Click OK to add the color property.  When the property is added, it will become visible in the 
takeoff tool dialog.  To edit or delete the property, click the … button at the far-right side of the 
property. 

− Add an Image property: In the Edit Image Property dialog, type the name of the image property in the 
Name input.  Click the Select Image button then navigate to and select the desired image.  The image 
will be displayed in the display area.  Click OK to add the image property.  When the property is added, it 
will become visible in the takeoff tool dialog.  To edit or delete the property, click the … button at the 
far-right side of the property. 

Once multiple properties have been added, the order of the properties can be rearranged by clicking the 
Property Order button located in the Takeoff tab of the dialog. 

Home Tab 

Side Panels 

From the drop-down list at the top of each side panel you can choose to display Pages, Estimating or Templates 
in either side.  The width of side panels can be adjusted by hovering the mouse over the vertical bar that 
separates the page area from the side panel to make the move arrows visible, then dragging the side panel to 
the desired width.  Side panels can also be hidden by clicking << or >> at the top right and top left of the side 
panels.  Side panels can also be undocked and moved around the screen or to another display by clicking the 
Undock buttons in the bottom right and left corners. 

− Pages: The Pages side panel contains 6 page related buttons: 
o Add Folder: Add a folder to the Pages side panel area.  Pages can then be placed inside of the 

folder for organizational purposes by dragging the page below the folder.  To move the page 
back out of the folder, drag the page above the folder. 

o Add Page: Adds additional pages to the project. 
o Duplicate Page: Makes a copy of the currently selected page. 
o Delete: Deletes the selected takeoff, page or folder. 
o Property: Make changes to the selected takeoff, page or folder.  For pages, batch rename and 

reposition pages using dialog buttons.  Dim a page by choosing the Dim percentage from the 
Page Dim drop down menu at the top right of the Name Page dialog. 

o Expand All: Expands all pages showing all page sub-items. 
o Collapse All: Collapses all pages hiding all page sub-items. 
o Organize: If a folder has been added to the Pages side panel, click the Organize button to batch 

move pages in and out of folders. 
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o Page Text Color: Changes the text color of the active page in the Pages side panel. 

The search field allows you to type characters that are compared against the page names narrowing the 
list of visible pages to help find pages faster.  When a sub-item has been added to a page, the “+” and “-
“ buttons to the left of the page allow you to expand or collapse the page making the sub-items either 
visible or not visible.  A page’s name can be changed by either double-clicking on the page or by clicking 
the Property button above.  The red and blue square button to the right of the page name will toggle 
the page back and forth between color and black & white.  The light bulb button to the right of the color 
button will toggle all takeoff items on that page from visible to invisible.  If the scale on a page has been 
set, the scale icon will appear to the right of the light bulb. 

 
− Estimating: The Estimating side panel contains 5 related buttons: 

o Add Folder: Add a folder to the Estimating side panel area.  Takeoff items can then be placed 
inside of the folder for organizational purposes by dragging the takeoff item below the folder.  
To remove the takeoff item from the folder, drag the item above the folder. 

o Duplicate:  Click to create a duplicate of the selected takeoff item. 
o Delete: Deletes the selected takeoff item or folder and all of its contents. 
o Expand All: Expands all assemblies in the Estimating side panel making all assembly sub-items 

visible. 
o Collapse All: Collapses all assemblies in the Estimating side panel making all assembly sub-items 

invisible. 

The search field allows you to type characters that are compared against the takeoff or assembly item 
names narrowing the list of visible takeoff items to help find items faster.  The “+” and “-“ buttons to the 
left of assemblies will expand or collapse the assembly which will make assembly sub-items either visible 
or invisible.  To launch a takeoff tool or assembly dialog from the Estimating side panel double click on 
the item’s icon to launch the dialog which will allow you to make changes prior to starting the takeoff.  
You can optionally hold down the Shift key while double-clicking to launch immediately into takeoff 
mode.  Once the dialog is launched, you can continue doing additional takeoff with the item by clicking 
the Continue Takeoff button at the bottom of the dialog.  The light bulb button toggles the visibility of 
the takeoff item on the page between visible and invisible.  The color button displays the color of the 
takeoff item on the page.  Click the color button to change the color of the takeoff item. 

− Templates: The Templates side panel contains 2 related buttons: 
o Expand All: Expands all assemblies in the Templates side panel making all assembly sub-items 

visible. 
o Collapse All: Collapses all assemblies in the Templates side panel making all assembly sub-items 

invisible. 

The assembly group drop down menu allows you to choose which assembly group to display in the side 
panel.  The + and - buttons to the left of assemblies will expand or collapse the assembly which will 
make assembly sub-items either visible or invisible.  To launch an assembly in either the Home, Page or 
Tools tab to perform a takeoff, click on the assembly to select it and then click the green button that 
appears to the left of the assembly’s name to launch its dialog allowing you to make changes prior to 
starting the takeoff.  Optionally hold down the Shift key while clicking the green button to launch 
directly into takeoff mode. 
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Page Area 

Clicking on a page in the Pages side panel will display the page in the page area.  You can add additional page 
display tabs by clicking the Add a Page tab above the page and selecting the desired additional page to be 
displayed in the Pages side panel.  Clicking on a page tab to select it and then clicking it again will display buttons 
allowing you to undock or delete the page tab.  Undocking a page will place it in a separate window that can be 
moved around the display or moved to another display.  Only one page panel can be active at a time.  Click into 
a page panel to make it the active panel.  Closing the undocked window will redock the page tab.  You can move 
the displayed page around in the page area by either sliding the vertical and horizontal scroll bars or by 
activating the pan tool by right click + hold and dragging the page around.  You can zoom the page in or out by 
either using the mouse wheel or by using the zoom buttons in the Zoom/Pan button group located in the Page 
tab.  If you wish to use the mouse wheel zooming functionality, be sure that the Mouse Wheel Controls Zoom 
check box is checked in the Preference dialog located in the File drop down menu.  At the bottom left corner of 
the application window the page scale, page size and measurement type is displayed.  At the bottom right 
corner of the application window are the following page related buttons: 

− Snap: Click the Snap button and set the Snap On checkbox to turn the Snap feature on.  The snap 
indicator circle color and size can optionally be changed at the top of the Snap Options dialog.  Set the 
appropriate snap mode check boxes.  It is best to select only the snap modes that you need for 
performance reasons.  Markup Grid will snap to grid corners when a grid overlay has been added to a 
page.  Markup Points will snap to markup points of markups that have been drawn on the page.  
Takeoff Points will snap to takeoff points of all takeoffs that have been added to a page.  Single Line 
Drawings will snap to corners of thin, single line plan drawings (page content).  This option will work 
well for uncluttered drawings such as roof plans or elevation plans without excess lines drawn.  For 
more cluttered drawings, this option will not provide much value.  Just be aware that this option works 
well in some cases and not in others, so it’s up to the user to determine when it’s appropriate to use.  
We recommend setting up a short cut key from the Preferences dialog (File -> Preference) to toggle 
Snap on and off.  This makes it faster if you need to toggle it on and off while performing a takeoff. 

− Box: Toggles the drawing mode for area, area cutout and linear takeoffs between standard and Box 
mode.  To draw in Box mode, click the first point at the top corner of the box and drag the cursor away 
from the first point diagonally, then click the second point to complete the box takeoff.  It is 
recommended that Ortho be toggled off when Box mode is active. 

− Ortho: Toggles between freehand and ortho drawing mode.  Ortho mode makes it easier to draw 
horizontal, vertical, and 45-degree lines. 

− Verify Points: When Verify Points is toggled on, when each takeoff point is added, a dialog is presented 
allowing for the distance from the previous point to the current point to be verified and adjusted if 
needed. 

− Layers: Up to 10 layers can be created to added takeoffs to.  Click the Layers button to launch the 
Takeoff Layers dialog.  Double click on a layer name to rename the layer.  When a takeoff tool is 
launched, select the desired layer to apply it to from the Layer drop-down menu.  Layers allow you to 
show, hide or lock all takeoff items in that layer at one time. 

Job Button Group 

The Job button group located at the top of the Home tab contains the following buttons related to job 
management: 

− New: To create a new job click the New button to launch the New Job dialog.  Enter a job name or 
quote number, an optional job description and optional job notes.  Select the job’s storage location and 
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choose the measurement type.  For metric jobs, choose the default measurement units from the drop-
down list to the right of the measurement type selection.  The default measurement units will 
automatically be set as default in the standard takeoff tools.   Select the type of plan files to be 
imported.  By default, TradeTek uses multi-core processing for bound pdf files.  Some user accounts 
have restrictions that don’t allow multi-core processing.  If the bound pdf processing is not working, 
uncheck the Multi-Core Bound PDF Processing check box.  In the Page Images area, choose to generate 
the page images in either Color, Mono or Both.  Click the Next button to continue.  Select the plan files 
to be imported.  For multiple individual files, select or highlight all files to be imported and click Ok or 
Open.  If you need to import multiple bound pdf files, choose one to import while creating the new job 
and then import the additional files by clicking the Add Pages button in the Pages side panel after the 
new job has been created. 

− Open: To open an existing job click the Open button, select the job storage location, select the desired 
job and click the Open button. 

− Property: To access the job properties of the open job, click the Property button.  Here you can modify 
or add new job properties.  You can modify or add default job properties from the main Templates tab -
> Set Default Properties tab and double click on Job Property.  Any changes that you make here will 
become the default settings for each newly created job moving forward.  You can add multiple job note 
categories that can be individually displayed in reports.  To add a new note category, click the Add 
button to the right of the Note drop-down menu, then add the notes in the Note field.  Note categories 
can also be set up in Set Default Properties. 

− Manage: To add job storage folders and move, copy to, clone, merge or delete jobs click the Manage 
button.  Here you can add folders to organize your jobs in, move jobs between folders, move jobs or 
folders containing jobs from one storage location to another, copy an existing job from one location to 
another, clone a job in the same storage location or merge multiple jobs into one job. 

− Storage: To create a new job storage location click the Storage button.  Click the New button, name the 
new storage location and then navigate to a folder that will contain the new storage location.  A job 
storage location can be added on your local computer, a network drive or in a cloud storage location.  
Other team members can access your job storage locations allowing them to access jobs that you have 
created if access is granted.  Click the Change Local Storage button to change the default location where 
all jobs are processed and local jobs are stored. 

− Import: To import a job file that has been exported from the app click the Import button, navigate to, 
and select the file to be imported.  Double clicking on a job file will automatically import the job. 

− Export: To export a job file click the Export button, optionally change the job file name, add an optional 
password, and click Ok.  By default, the file will be saved to your desktop, click the Change Location 
button to change the location for the file to be saved to. 

Navigate Button Group 

The Navigate button group located at the top of the Home tab contains the following buttons related to page 
navigation: 

− Back: Once you have navigated through some pages by clicking on them in the Pages side panel, you can 
go back 1 level at a time in the reverse order that you navigated by clicking the Back button. 

− Forward: Once you have navigated backwards through your page selections, you can go forward one 
level at a time in the reverse order by clicking the Forward button. 
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Dimension Button Group 

− Scale: To set the page scale click the Scale button located in the main Home tab in the Dimension 
button group.  You can choose to either set the scale from the drop-down list or set a manual scale 
based on a known dimension on the plan page.  To set the scale from the drop-down list simply choose 
the appropriate scale from the list in the From List tab of the dialog.  To set a manual scale, click on the 
Manual Scale tab and follow the instructions in the dialog.  Once the scale has been set, use the 
Measure tool to check against several dimensions on the plan page to ensure that they are matching up.  
YOU ARE RESPONSIBLE FOR ENSURING THAT THE SCALE HAS BEEN ACCURATELY SET FOR THE PAGE(S).  
WE WILL NOT BE HELD RESPONSIBLE FOR ANY LOSS DUE TO INCORRECT CALIBRATION OF PAGES. 

− Measure: To measure a distance on a plan page, from the main Home tab in the Dimension button 
group, click on the Measure tool.  Click on the starting point and then the ending point of the dimension 
and the measured dimension will be displayed in a message box. 

Takeoff Button Group 

The takeoff tools are located in the Takeoff button group in the Home tab.  Default characteristics for each 
takeoff tool can be set in the Templates main tab in the Set Default Properties tab.  From within the Set Default 
Properties tab, click on a takeoff tool to launch its dialog, make changes, or add properties and this will become 
the default configuration for that takeoff tool.  You can add up to 10 custom properties in the Info tab and 10 
custom properties in the Takeoff tab. 

− Area Takeoff Tool: Once the active page has been scaled the area takeoff tool can be used to perform 
an area takeoff.  From the Home tab, click the Area button in the Takeoff button group to launch the 
dialog.   
The following inputs are found under the Info tab: 

o Name: Type in the name of the area takeoff. 
o Multiply: The area measurement will be multiplied by the number in the Multiply input. 
o Quantity: The default value is [Area] which will result in the area square footage.  Click the … 

button to the right of the Quantity input to add a custom calculation formula for the quantity 
value.  The formula editor works the same as described above for Add a Number property. 

o Units: Change the quantity value units. 
o Color:  This is the color of the takeoff item on the page.  Colors are selected randomly by default 

but can be changed by the user here. 
o Pitch (_/12): Add a pitch factor to the Area takeoff property value located in the Takeoff tab. 
o Add Property:  Add up to 10 custom properties in the Info tab. 
o Refresh: The refresh button will refresh the values of all properties when changes have been 

made. 
o Folder:  If a takeoff folder(s) has been added in the Estimating tab, a folder can be selected from 

the drop-down list for the takeoff item to be placed into.  A takeoff folder can be pre-set in the 
tool by typing the name of a folder to the right of Default Folder in the dialog.  If a folder by that 
name exists in the Estimating tab, the takeoff will be placed in that folder.  If the folder does not 
exist, one will be created. 

The following inputs are found under the Takeoff tab: 
o Area: Displays the area takeoff measurement which can be adjusted by the Multiply and Pitch 

inputs in the Info tab. 
o Segment Count: Displays the number of perimeter line segments.  A line segment is a portion of 

the perimeter line between 2 points. 
o Point Count: Displays the total number of takeoff points around the perimeter of the area. 
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o Perimeter Linear: Displays the total linear measurement around the perimeter of the area. 
o Section Count: Displays the total number of takeoff sections that have been created.  A takeoff 

section represents one instance of a takeoff.  For example, if an Area takeoff tool is launched 
and 2 rectangular takeoffs are drawn on a page then 2 takeoff sections have been created. 

o Add Property: Add up to 10 custom properties in the Takeoff tab. 
Click the OK button at the bottom right corner of the Area Takeoff dialog to start the takeoff.  Click the 
first point on the page to start the takeoff and then click all the required perimeter points to complete 
the takeoff.  To end the takeoff, tap the Esc key.  To end one takeoff section and start a new takeoff 
section either double click at the last point of the section or tap the N key.  To undo the last takeoff 
point while the tool remains active, tap the Shift key.  To draw an area curve, click the starting point of 
the curve then tap the C key to toggle the tool into curve mode, click the second point of the curve then 
move the cursor to shape the curve as needed then tap any arrow key to capture the curve (use the 
arrow keys to adjust the curve as needed).  Tap the C key again to toggle the tool out of curve mode. 
 

− Area Cutout Tool: To cut out an area within an existing area takeoff, launch the Area Cutout tool.  Click 
the first point over the existing area to start the cutout and then click all the required perimeter points 
to complete the cutout.  To end the cutout, tap the Esc key. 

− Linear Takeoff Tool: Once the active page has been scaled the linear takeoff tool can be used to perform 
a linear takeoff.  From the Home tab, click the Linear button in the Takeoff button group to launch the 
dialog.   
The following inputs are found under the Info tab: 

o Name: Type in the name of the linear takeoff. 
o Multiply: The linear measurement will be multiplied by the number in the Multiply input. 
o Quantity: The default value is [Linear] which will result in the takeoff linear footage.  Click the … 

button to the right of the Quantity input to add a custom calculation formula for the quantity 
value.  The formula editor works the same as described above for Add a Number property. 

o Units: Change the quantity value units. 
o Color:  This is the color of the takeoff item on the page.  Colors are selected randomly by default 

but can be changed by the user here. 
o Pitch (_/12): Add a pitch factor to the Linear takeoff property value located in the Takeoff tab. 
o Add Property:  Add up to 10 custom properties in the Info tab. 
o Refresh: The refresh button will refresh the values of all properties when changes have been 

made. 
o Line Width:  Set the width of the line that is drawn on the page. 
o Line Width Units:  Set the units of the line width that is drawn on the page. 
o Folder:  If a takeoff folder(s) has been added in the Estimating tab, a folder can be selected from 

the drop-down list for the takeoff item to be placed into.  A takeoff folder can be pre-set in the 
tool by typing the name of a folder to the right of Default Folder in the dialog.  If a folder by that 
name exists in the Estimating tab, the takeoff will be placed in that folder.  If the folder does not 
exist, one will be created. 

The following inputs are found under the Takeoff tab: 
o Linear: Displays the linear takeoff measurement which can be adjusted by the Multiply and 

Pitch inputs in the Info tab. 
o Segment Count: Displays the number of line segments.  A line segment is a portion of the linear 

between 2 points. 
o Point Count: Displays the total number of takeoff points in the linear takeoff. 
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o Section Count: Displays the total number of takeoff sections that have been created.  A takeoff 
section represents one instance of a takeoff.  For example, if a Linear takeoff tool is launched 
and 2 separate lines are drawn on a page then 2 takeoff sections have been created. 

o Add Property: Add up to 10 custom properties in the Takeoff tab. 
Click the OK button at the bottom right corner of the Linear Takeoff dialog to start the takeoff.  Click the 
first point on the page to start the takeoff and then click all the required linear points to complete the 
takeoff.  To end the takeoff, tap the Esc key.  To end one takeoff section and start a new takeoff section 
either double click at the last point of the section or tap the N key.  To undo the last takeoff point while 
the tool remains active, tap the Shift key.  To draw a linear curve, click the starting point of the curve 
then tap the C key to toggle the tool into curve mode, click the second point of the curve then move the 
cursor to shape the curve as needed then tap any arrow key to capture the curve (use the arrow keys to 
adjust the curve as needed).  Tap the C key again to toggle the tool out of curve mode. 

− Segment Takeoff Tool: Once the active page has been scaled the segment takeoff tool can be used to 
perform a segment takeoff.  From the Home tab, click the Segment button in the Takeoff button group 
to launch the dialog.   
The following inputs are found under the Info tab: 

o Name: Type in the name of the segment takeoff. 
o Multiply: The linear measurement will be multiplied by the number in the Multiply input. 
o Quantity: The default value is [Linear] which will result in the takeoff linear footage.  Click the … 

button to the right of the Quantity input to add a custom calculation formula for the quantity 
value.  The formula editor works the same as described above for Add a Number property. 

o Units: Change the quantity value units. 
o Color:  This is the color of the takeoff item on the page.  Colors are selected randomly by default 

but can be changed by the user here. 
o Pitch (_/12): Add a pitch factor to the Linear takeoff property value located in the Takeoff tab. 
o Add Property:  Add up to 10 custom properties in the Info tab. 
o Refresh: The refresh button will refresh the values of all properties when changes have been 

made. 
o Line Width:  Set the width of the line that is drawn on the page. 
o Line Width Units:  Allows the user to set the units of the line width that is drawn on the page. 
o Folder:  If a takeoff folder(s) has been added in the Estimating tab, a folder can be selected from 

the drop-down list for the takeoff item to be placed into.  A takeoff folder can be pre-set in the 
tool by typing the name of a folder to the right of Default Folder in the dialog.  If a folder by that 
name exists in the Estimating tab, the takeoff will be placed in that folder.  If the folder does not 
exist, one will be created. 

The following inputs are found under the Takeoff tab: 
o Linear: Displays the linear takeoff measurement which can be adjusted by the Multiply and 

Pitch inputs in the Info tab. 
o Segment Count: Displays the number of line segments.  A line segment is a portion of the linear 

between 2 points. 
o Point Count: Displays the total number of takeoff points in the segment takeoff. 
o Section Count: Displays the total number of takeoff sections that have been created.  A takeoff 

section represents one instance of a takeoff.  For example, if a Segment takeoff tool is launched 
and 2 separate lines are drawn on a page then 2 takeoff sections have been created. 

o Add Property: Add up to 10 custom properties in the Takeoff tab. 
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Click the OK button at the bottom right corner of the Segment Takeoff dialog to start the takeoff.  Click 
the first point on the page to start the takeoff and then click the second point of the segment to end the 
current section.  Click the next point to start the next new section.  To end the takeoff, tap the Esc key. 

− Count Takeoff Tool: Once the active page has been scaled the count takeoff tool can be used to perform 
a count takeoff.  From the Home tab, click the Count button in the Takeoff button group to launch the 
dialog.   
The following inputs are found under the Info tab: 

o Name: Type in the name of the count takeoff. 
o Multiply: The count will be multiplied by the number in the Multiply input. 
o Quantity: The default value is [Count] which will result in the takeoff count.  Click the … button 

to the right of the Quantity input to add a custom calculation formula for the quantity value.  
The formula editor works the same as described above for Add a Number property. 

o Units: Change the quantity value units. 
o Color:  This is the color of the takeoff item on the page.  Colors are selected randomly by default 

but can be changed by the user here. 
o Shape: Choose the shape of the takeoff item as seen on the page from a drop-down selection. 
o Add Property:  Add up to 10 custom properties in the Info tab. 
o Refresh: The refresh button will refresh the values of all properties when changes have been 

made. 
o Folder:  If a takeoff folder(s) has been added in the Estimating tab, a folder can be selected from 

the drop-down list for the takeoff item to be placed into.  A takeoff folder can be pre-set in the 
tool by typing the name of a folder to the right of Default Folder in the dialog.  If a folder by that 
name exists in the Estimating tab, the takeoff will be placed in that folder.  If the folder does not 
exist, one will be created. 

The following inputs are found under the Takeoff tab: 
o Point Count: Displays the total number of takeoff points. 
o Shape Width (Units): Set the shape width and width units as seen on the page. 
o Shape Length (Units): Set the shape length and length units as seen on the page. 
o Add Property:  Add up to 10 custom properties in the Info tab. 

− Copy & Paste Tools: To copy an existing takeoff item, select the item on the page by clicking on it and 
then click the Copy button. 

Adjust Takeoffs 

− Continue a Takeoff: Once at least 1 takeoff section has been added, the takeoff item becomes visible 
beneath the active page in the Pages side panel.  To re-launch the takeoff tool to add more takeoff 
sections, double click on the takeoff item to launch the dialog and click the Continue Takeoff button at 
the bottom of the dialog, or optionally hold down the Shift key while double clicking to launch 
immediately into takeoff mode.   

− Move a Takeoff Section: To move a takeoff section on a page, left-click-hold, drag the section to the 
desired new location and release. 

− Add a Takeoff Point: To insert a takeoff point into a linear or area perimeter linear line, place the cursor 
in the desired location of the new point and double click. 

− Delete a Takeoff Point: To delete a takeoff point, select the takeoff section to make the points visible 
then double click on the point that you would like to delete. 

− Move a Takeoff Point: To move a takeoff point on a page, left-click-hold, drag the point to the desired 
new location and release. 
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Page Tab 

The side panels and main page area in the Page tab are the same as in the Home tab.  For information regarding 
the side panels or main page area, refer to those sections under the Home Tab area of the user’s guide. 

Zoom/Pan Button Group 

The Zoom/Pan button group located at the top of the Page tab contains the following buttons related to page 
navigation: 

− Fit Page: Adjusts the selected page to the lowest zoom level, allowing the entire page to be visible in the 
page area. 

− Zoom In: Adjusts the selected page’s zoom level up 1 level. 
− Zoom Out: Adjusts the selected page’s zoom level down 1 level. 
− Pan: Toggles the cursor to pan mode, allowing you to left click + hold and drag the page around.  Click 

the Pan button again to toggle pan mode off. 

Rotate Button Group 

The Rotate button group located at the top of the Page tab contains the following buttons related to page 
adjustment: 

− Left: Rotates the selected page 90 degrees to the left. 
− Right: Rotates the selected page 90 degrees to the right. 
− 180: Rotates the selected page 180 degrees. 
− Level: To horizontally level a page, click the Level button and follow the instructions in the dialog.   
− Batch: To rotate more than one page at a time, click the Batch button and selected the desired pages a 

rotate function from the dialog. 

Flip Button Group 

The Flip button group located at the top of the Page tab contains the following buttons related to page 
adjustment: 

− Vertical: Flips the selected page 180 degrees vertically. 
− Horizontal: Flips the selected page 180 degrees horizontally. 

Markup Button Group 

The Markup button group located at the top of the Page tab contains the following buttons related to page 
markups: 

− Draw: From the Draw Markup dialog, select an Arrow, Box, Pen, Circle, Rnd Box, or Area markup tool, 
set its properties.  Draw markups can be applied in layers, select the appropriate layer for the Layer 
drop-down menu.  Click the OK button to launch the tool.  Pattern images can be added to area 
markups.  To select a pattern image to apply to an area markup, click the Pattern button at the bottom 
right corner of the markup dialog for Area, choose the appropriate pattern and set its properties.  To 
access the pattern library, from the Template tab, click the Set Defualt Property tab then click on 
Pattern Images.  Select a markup tool section and delete it with the Delete key, move a markup section 
by click and dragging it to the new location.  To add or remove a markup point, click on the markup to 
select it, then double click on an existing point to present the manage points dialog.  To enter curve 
mode with a pen or area markup, press C.  When you click the next point, you can change the curve 
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between those points.  Press C again to exit curve mode.  To complete a markup, tap the Esc key, to end 
one markup section and start another, double-click or tap the N key.  Default properties can be set for 
the draw tools in the Set Default Properties tab in the Template tab. 

− Highlight: From the Highlight Markup dialog, select a Box or Pen highlighter tool, set its properties and 
click the OK button to launch the tool.  Select a highlighter section and delete it with the Delete key, 
move a highlighter section by selecting it and tapping the arrow keys (hold down the Shift key to speed 
up), press the Shift key to undo the last point while the highlighter tool is active.  To complete a 
highlighter markup, tap the Esc key, to end one highlighter section and start another, double-click or tap 
the N key.  Default properties can be set for the highlighter tools in the Set Default Properties tab in the 
Template tab. 

− Note: From the Markup Note dialog, type the note text in the text area.  Set the font style, font size, 
text color, text alignment in note, note color and note transparency (these default settings can be 
changed in the Set Default Property tab located in the Template tab).  Click the Link button to add a link 
to a file stored in the job (will be included in an exported job file), an external file or a URL.  Click the OK 
button, click the first point at the top left corner of the desired note position then click the second point 
at the bottom right corner of the note.  Click the green circle in the bottom left corner to display the 
linked item.  Double click in the note area to re-launch the dialog to make adjustments to the note.  Click 
in the note area to select it then tap the Delete key to delete the note. 

− Image: From the Markup Image dialog, select either Stored in Job or External File.  An image that is 
stored in the job will be included in an exported job file while an external file will only be available from 
your computer.  Images can be assigned to different markup layers.  Select the appropriate layer from 
the Layer drop-down menu.  Click the New button to create a new image by utilizing the built-in image 
editor.  To add an image that is saved to the clipboard, click the Clipboard button.  To add an image 
from the Patterns library, click the Patterns button.  To add an image that is saved to the local 
computer, click the Disk button.  Click the first point at the top left corner of the desired image location 
then click the second point at the bottom right corner to add the image.  Left-click-hold and drag to 
reposition the image.  Click on the image to select it then tap the Delete key to delete the image. 

− Overlay: From the Markup Overlay dialog, name the overlay, select the page to be overlayed onto the 
currently displayed page, adjust the overlay transparency and overlay color if needed.  Click the OK 
button to add the page overlay.  

− Grid Layers: Click the Grid Layers button to set up a page grid overlay and to define and modify markup 
layers.  Set the appropriate radio button for no grid, visible grid or to adjust the grid.  Select the desired 
grid line type from the drop-down menu.  Select the grid line distance increments and desired dimness 
from the drop-down menus and choose the grid line color.  To save a copy of the currently formatted 
grid to use on a different page, use the Save and Load buttons.  To modify markup layers, click the 
Layers button.  Double click on a layer name to modify the name.  To hide or lock a layer, set the 
appropriate check boxes.  To set a layer to the “plan” level so that all takeoffs and all other markup 
layers are placed on top of the layer, set the Plan checkbox. 

− Markup Tools: To perform actions on the selected markup items, click the Markup Tools button.  From 
the Markup Tools dialog you can copy and paste markup items, rotate left or right, flip vertical and 
horizontal, and bring to front or send to back.  Click and drag markup points to move them, double click 
to add or delete markup points. 

Tool Tab 

The side panels and main page area in the Page tab are the same as in the Home tab.  For information regarding 
the side panels or main page area, refer to those sections under the Home Tab area of the user’s guide. 
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Takeoff Item Button Group 

The Takeoff Item button group located at the top of the Tool tab contains the following buttons related to 
takeoff item adjustment: 

− Rotate Left: Rotates the selected takeoff section on a page 90 degrees to the left. 
− Rotate Right: Rotates the selected takeoff section on a page 90 degrees to the right. 
− Flip Horizontal: Flips the selected takeoff section on a page 180 degrees horizontally. 
− Flip Vertical: Flips the selected takeoff section on a page 180 degrees vertically. 

Calculation Button Group 

The Calculation button group located at the top of the Tool tab contains the following buttons related to 
determining pitch and angles on a page: 

− Pitch: Click the anchor point on a page, then move the mouse away aligning the guideline with a line on 
the drawing to determine its pitch.  Click the second point to terminate the tool. 

− Triangulate: Click three points on the page to set the two legs of a triangle and the diagonal length, leg 
lengths and corner angles are provided.  Click on one of the corner circles to select the triangle to delete 
it. 

Image Tool Button Group 

The Image Tool button group located at the top of the Page tab contains the following buttons related to page 
images: 

− Crop as New Page: Click the Crop as New Page button to launch the tool.  Click the first point at the top 
left corner of the desired crop area, then click the second point at the bottom right corner of the crop 
area (will be highlighted in blue).  Name the new page then click OK.  The new page will be added at the 
bottom of the page list in the Pages side panel. 

− Copy to Clipboard: Click the Copy to Clipboard button to launch the tool.  Click the first point at the top 
left corner of the desired area then click the second point at the bottom right corner of the area (will be 
highlighted in blue).  The selected area is now placed in the clipboard and is available to paste. 

− Screenshot: To capture the entire selected page with all takeoff and page items, click the Screenshot 
button.  Name the screenshot file and choose the desired file type.  The screenshot file will be saved to 
the desktop. 

− Batch Screenshot: To generate screenshots of multiple pages at the same time, click the Batch 
Screenshot button.  Name the folder that the screenshots will be placed in on the desktop, set the 
appropriate file type radio button and then set the check box next to each desired page then click the 
OK button to process the screenshots.  To send the files to the printer or to a PDF printer, select either 
the Print or Merged Print radio button.  Click the Page Setup button to adjust the appropriate page 
settings.  You can optionally set one of the three location option check boxes if the screenshot size does 
not match exactly with the print page size. 

− Page Legend: Click the Page Legend button to toggle the page legend on and off.  Click the legend to 
select it and move the perimeter points to resize the legend.  Select and drag the legend to reposition it 
on the page. 

− Fix PDF: When PDF pages are created at a size other than what they were drawn at, this can cause both 
resolution and scaling issues.  Use the Fix PDF button to correct either or both of these issues.  Fix PDF 
allows you to increase the resolution of the page and can stretch pages to the correct proportion to 
allow for accurate scaling of the page.  When page files are imported into TradeTek, they are converted 
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to PNG files.  If one of the PNG files is too large, it can cause various problems.  To resolve the issues 
caused by big image files, from the Fix PNG or JPG Images tab,  read the provided information to 
understand how the process works, then click the OK button to run the process. 

− Capture Text: Click the Capture Text button to scan an area of text on the page and convert it to text 
that can be pasted into other applications like Excel or Word.  Once an area has been successfully 
scanned, the converted text is placed in the clipboard.  Select the Text in Dialog radio button to have 
the text displayed in a dialog box, Clipboard Beep to trigger a sound when the text is captured or Show 
Text Editor to place the captured text in a text editor.  Set the appropriate AI Engine radio button to 
power the process.  Click the OK button to select a page region area and then scan all of the pages in the 
job into text that can then be searched.  From the Scan all Pages and PDF Files for Search tab, click the 
Scan Pages button to capture text from all pages in the currently opened job.  Click the Text from PDF 
button to scan an external PDF file into text that can then be searched.  Click the Clear Scans button to 
clear all stored text from previous scans.  Click the Search button to perform a search on previously 
scanned text. 

Estimating Tab 

Side Panels 

The left side Estimating Layout side panel is where the default and user added estimating layouts are located.  
Select the estimating layout that you want displayed in the estimating area. 

The Estimating Layout side panel contains 7 related buttons: 

− Add Layout: Click the Add Layout button to add a new estimating layout.  Give the new layout a name 
and select the property value columns that you would like displayed in the layout from the Add Column 
Name drop-down menu.  The list of available property values is generated from all properties located in 
assembly groups within the Template tab, the Set Default Properties area and takeoff items within the 
Estimating tab.  Once you have added all the desired property value columns, click OK to add the new 
layout. 

− Property: Launches the layout dialog for the selected layout allowing you to make changes. 
− Delete: Deletes the selected layout. 
− Import Layout: Imports an estimating layout that has been exported from another computer. 
− Export Layout: Exports the selected estimating layout file to the Desktop that can be imported by 

another computer. 
− Up & Down Arrows: Moves the selected layout up or down in the list. 

The right-side panel displays the Template side panel.  For more information regarding the Template side panel, 
refer to its section under the Home tab. 

The main Estimating area is where all takeoff for the opened job is located.  The + and - buttons to the left of 
folders and takeoff items allow you to expand or collapse the item making its sub-items visible or invisible.  Click 
the Fill button to batch fill property values by selecting the property from the drop-down menu, typing in the 
new value then selecting the appropriate items to update. The Search field at the top right corner of the 
Estimating area allows you to type characters that are matched against the takeoff item names, reducing the 
number of visible items to help find takeoff items faster.  Click the Find button to search all items in the 
Estimating tab for the entered text in the selected item.  Click the Delete button to delete multiple takeoffs or 
assemblies at one time.  Set the Reorder check box to allow items to be moved around in the main Estimating 
area. 
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Estimate Button Group 

The Estimate button group located at the top of the Estimating tab contains the following buttons related to 
Estimate area actions: 

− New Folder: Adds a new takeoff folder to the estimating area.  Takeoff folders can contain properties 
that can be accessed by the takeoff items inside of the folder.  For more information on takeoff folder 
properties refer to the Properties section of the user’s guide.  When a new folder is added, it will be 
added beneath the last item in the estimating area.  To move takeoff items into a folder, left click + hold 
on the takeoff item icon and drag the item below the folder.  To move an item out of a folder, click and 
drag it above the folder.  Folders can be moved up or down in the estimating area by left click + hold on 
the folder icon and dragging it to the desire position. 

− Delete: Deletes the selected item(s) in the estimating area. 
− Edit: Launches the selected takeoff item dialog. 
− Expand All: Expands all folders and assemblies in the estimating area so that all sub-items are visible. 
− Collapse All: Collapses all folders and assemblies in the estimating area so that all sub-items are 

invisible. 
− Export Data: Exports the data in the Estimating tab to CSV or Excel.  Click the More Options button to 

select specific columns and change the export file type. 
− Add Manual: Click to add a manual assembly to the job.  Select the appropriate manual assembly from 

the drop-down menu.  You can also add a manual assembly to the job from the Estimating tab by 
double-clicking on it in the Template right side panel. 

− Folder Preset: An Estimating tab folder structure can be created in the currently opened job and then 
stored for later use.  Create the desired folder structure in the currently opened job, then click the 
Folder Preset button and click the New button to add a new structure.  To add the new structure to a 
new job, from the Estimating tab click the Folder Preset button, select the desired preset then click the 
Apply button. 

Clipboard Button Group 

− Copy: Copies the selected item(s) in the estimating area to the clipboard. 
− Paste: Pastes the items in the clipboard into the estimating area. 

List Tab 

Lists with multiple columns can be created that properties can be connected to.  Takeoff folder and takeoff tool 
properties can be connected to a single column list to create a drop-down menu to choose values from.  
Assembly sub-items can be connected to multiple column lists and when the sub-item name is chosen from the 
drop-down menu, other properties in the sub-item that have the same name as a column name in the list will be 
updated from the data in the other columns for that item.  If an assembly sub-item property has the same name 
as a connected list column name, but you do not want that property value updated (you want to enter the 
property value manually) type the word IGNORE for that property value in the connected list. 

Side Panel 

The left side List side panel is where the default and user added lists are located.  Select the list that you want 
displayed in the list area. 

The List side panel contains 7 list related buttons: 
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− Add List: The Add List button launches the List Layout dialog, allowing you to either add a local list or 
connect to an external list.  You can add a local list and create the entire list all within the application or 
connect to an external list file and import the list.  With an external list, the connection to the source file 
is maintained so that when updates are made to the file, the list in the application can be updated.  In 
the List Name field relace the New List Layout text with the name of your new list and then choose 
either Local or External list type: 

o Local List: Add the desired columns by choosing them from the Add Column Name drop-down 
menu and click the OK button to create the list. 

o External List: Choose the type of file that you will be connecting to: 
 
CSV files can optionally be password protected.  This allows you to either allow access to lists by 
other users or send lists to other users that require a password to connect to or import in.  We 
recommend the use of .csv files for external lists when possible because there is a little more 
capability in the application when working with .csv files as opposed to other file types. 
 
 CSV File On Disk – Connect the list to a .csv file that is located on your computer, on a 

server, in dropbox or any other drive or folder that you can choose from.  To connect 
the list, choose the CSV File on Disk radio button and click the Select button at right, 
navigate to and select the list file.  See List Layout Dialog section below for further 
instructions.  To ensure that non-ASCII special characters are supported, save the CSV 
file as a CSV UTF-8 file type. 

 CSV File at URL – Connect the list to a .csv file that is located on a website.  To connect 
the list, choose the CSV File at URL radio button, type the exact url into the URL field 
and click the Load URL button.  See List Layout Dialog section below for further 
instructions.  To ensure that non-ASCII special characters are supported, save the CSV 
file as a CSV UTF-8 file type. 

 ODBC Connection – Connect the list using an ODBC connection that will allow you to 
create a database connection to a Microsoft Excel Workbook, Microsoft Access 
Database file and any other database file that is supported by Microsoft ODBC.  To 
connect the list, choose the ODBC Connection radio button and click the Select button 
to launch the ODBC setup dialog, then do the following: 

1.  Click the Databases button to create a new database connection.   
2. In the next dialog, click the Add… button to add a new database connection. 
3. In the Create New Data Source dialog, choose the appropriate ODBC driver that 

supports the file type of your database file.  If you don’t see the file type in the 
list that you need, proceed to step 4, otherwise proceed to step 5. 

4. Cancel the last 2 dialogs and on the ODBC, dialog click the Install ODBC Driver 
button at the bottom left corner and follow the prompts.  This will install the 
latest version of Microsoft’s ODBC driver for Windows users and will install a 3rd 
party ODBC driver for Mac users.  If you are connecting to a file type that is not 
supported by the standard driver, you may be able to obtain an OBDC driver for 
that specific file type that will allow this connection to work.  Return to step 1. 

5. Select the appropriate file type from the list and click the Finish button. 
6. In the next dialog, name the new dialog source and make the required 

selections depending on your file type, then click the OK button to add the data 
source. 
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7. You should now see your newly defined data source in the User Data Sources 
list.  Click OK to dismiss the dialog. 

8. In the ODBC dialog click the Select button and choose the data source that you 
want to connect this list to. 

9. If connecting to a Microsoft Excel workbook or spreadsheet, check the Excel 
Workbook check box in the ODBC dialog. 

10. Click the Connect button in the ODBC dialog. 
11. Choose the sheet or table in the Select Table list to create the new list from 

then click the OK button to import the list.  Even if there is only 1 option, you 
must select it before proceeding to step 12. 

12. See List Layout Dialog section below for further instructions. 
 TradeTek Cloud – Connect the list to a cloud list that has already been created in the 

cloud.  Click the List Name button then choose the appropriate cloud list to connect to. 

 

 

o List Layout Dialog: Once the data source connection has been made, the List Layout dialog will 
be presented in the Preview tab.  You can scroll horizontally and vertically to preview the data 
from the connected source to verify the connection.  Click the Setup tab at the top left corner of 
the dialog and perform the following steps: 

1. You will need to map (connect) the columns that you add in the internal list to the 
appropriate columns in the database file.  You can either choose to select the database 
file columns by column number or by column header name.  Make your selection by 
setting either the Number or Name Map by Column radio button. 

2. If your database file does not contain column header row names in row 1, check the 
Ignore Header Row check box and set the Map by Column radio button to Number. 

3. Add columns to the internal list by clicking the Add Column Name drop-down menu and 
selecting a property name.  By default, the Name column is added to each new list.  
Internal list column header names must match existing property names that exist either 
in an assembly in the Template tab, a takeoff tool in the Set Default Property tab, or a 
takeoff item in the Estimating tab.  The properties will only be available to choose from 
the column name drop-down menus once they have been added as a property in one of 
the items mentioned above. 

4. Once all the desired internal columns have been added, click on the first column name 
and then click the Map Column button to connect it to a database file column.  Choose 
either the column number or column name from the source file to connect to. 

5. Repeat step 4 for all added internal column names. 
6. Once all added columns have been mapped, click the OK button to complete the 

connection and create the new list.  The new list name will now be visible in left side 
panel. 

7. Derived Columns can be added to external lists.  Derived columns allow you to add 
columns of data where you want to enter the data manually in the list in TradeTek (the 
data is not coming from the source file).  For example, you could add a derived column 
to an external lumber list called “Coverage” where you could enter the material 
coverage for that item that you may want to bring into a sub-item property named 
Coverage that can be referenced in the calculation formula for that item.  Derived 
columns are connected to the value identified as the “Key Property” so that if items get 
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moved in the list, their derived column values move with them.  To add a derived 
column, select the list and then click the Property button to display the List Layout 
dialog.  Click the Derived Column button, then click the Add button and follow the 
prompts. 

− Property: The Property button launches the List Layout dialog allowing you to make changes to the 
selected list. 

− Delete: Deletes the selected list. 
− Import List: Imports a list file that has been exported from another computer.  Double clicking on a list 

file will automatically import the list. 
− Export List: Exports the selected list file to the desktop to be imported by another computer. 
− Archive List: Archives a copy of the currently selected list file by date. 
− Restore List: Restores the currently selected list from the chosen archived list file. 
− Up: Moves the selected list up 1 row in the side panel. 
− Down: Moves the selected list down 1 row in the side panel. 

List Area 

To edit a list, click the Editable checkbox at the top of the list area and click into the cell that you would like to 
edit.  To edit data in derived columns in an external list, the Editable check box does not need to be checked.  
For multiple column lists set the Tab radio button at the top of the list to Right and for single column lists set the 
Tab radio button to Down to make adding and editing list items faster.  To search for an item in the list, type the 
name of the item into the search box at the top of the list area, choose the column to search in from the drop-
down menu and click the Find button.  Each time you click the button it will proceed to the next match item in 
the list.  To add a row to the list, select a row and click the Add Row button and the new row will be added 
above the selected row.  To delete a row, select the row to be deleted and click the Delete Row button at the 
top of the list area.  To do a bulk add of data into a list column click the Fill button then choose the column name 
from the drop-down menu, choose the starting and ending rows, type the value to be added then click the OK 
button. 

Update Button Group 

The Update button group located at the top of the List tab contains the following buttons related to updating 
lists and updating properties connected to lists: 

− Update List: Updates the data in external lists from their source data file. 
− Update Assembly: Once the data in a list has been updated, all properties that have been connected to 

that list located in assembly groups in the Template tab will be updated. 
− Update Job: Once the data in a list has been updated, all properties of takeoff items that have been 

connected to that list in the Estimating tab of the currently opened job will be updated. 

Clipboard Button Group 

The Clipboard button group located at the top of the List tab contains the following buttons related to copying 
data in and out of local lists: 

− Copy Table: Copies all data in the selected list to the clipboard that can then be pasted into other 
locations, such as a Microsoft Excel spreadsheet. 

− Paste Table: Pastes all data from the clipboard into the selected local list.  For example, you can copy an 
entire spreadsheet and paste into the selected local list.  The number of columns in the copied location 
must match the number of columns in the local list. 
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− Copy Columns: Launches the Copy Columns dialog.  Type a number at the top of each column to copy its 
data and number it to specify the order that you want the individual columns pasted in.  Click the OK 
button to copy to clipboard.  The columns can now be pasted to another locations, such as an external 
spreadsheet. 

− Paste Columns: Once you have copied columns(s) of data from an external source, click to launch the 
Paste Columns dialog.  Type a number at the top of each column to specify the order in which to paste 
each column of data into the selected local list. 

Tools Button Group 

The Tools button group located at the top of the List tab contains the following buttons related to protecting 
external lists created from CSV files and adding property images: 

− Encrypt Decrypt: Launches the CSV Encryption dialog.  Create a password using 5 or more characters of 
A..Z, a..z or 0..9.  Click the Select CSV File button, navigate to and select the CSV source file of the 
selected list then click the Encrypt button.  At this point, any other user that either attempts to connect 
to the same source file or to import a list file connected to the source file must enter the password 
successfully to complete the connection or import.  You can check the status of a source file by clicking 
the Status button and can decrypt a source file by clicking the Decrypt button. 

− Property Images: Launches the Property Images dialog.  All images that will be used as a property image 
must be added here in the property images library first.  Property images will typically be displayed in a 
cell in TradeTek, either in the Estimating tab when a column has been added to the Estimating layout to 
display the column, in a list in the List tab when a derived column of type Image has been added to an 
external list or a column of type Image has been added to a local list, or in a column in a report.  In the 
Property Images dialog, choose the image size at the bottom of the dialog, set any of the optional 
parameters and click the Add button to navigate to and select the image to import.  When selecting the 
image import size, keep in mind the size of the area that you intend the image to be displayed, and 
match the import size to the display size as closely as possible.  Once a property image has been 
imported, it can now be added either as an image property in a dialog, or can be added to an item in an 
image column of a local list or a derived column of type image in an external list.  Once images are 
added to lists, they will be updated in any assembly sub-items that are connected to that list as with all 
other property types.  To add a property image to a list, click in the cell where you want to add the 
image, then click the Property Images button, click on the desired image then click the Select button. 

List Connection Button Group 

The List Connection button group located at the top of the List tab contains the following buttons related to 
linking vendor lists together so that you can easily compare pricing for the opened job: 

− List Map: Launches the List Map dialog.  This dialog allows you to connect up to four lists together by 
mapping like item names so that price comparisons can be generated.  In the Default List column, 
choose the desired list and column containing the item names to be mapped.  Add up to three 
additional lists by selecting the list and column containing the item names to be mapped.  Click the 
Populate Default Values button at the bottom left corner of the dialog to load the Default List item 
names.  For List 2, click into the cell at the first row and the item names for that list are populated in the 
Find Value area to the right.  Start typing characters to search for an item name and the list narrows 
based on your search.  Select the appropriate matching item to the Default List’s item for that row, then 
click the Set button at the top right corner to make the selection.  Continue through all rows of the 
additional lists until all item names have been mapped.  All mapping is saved so that when you update 
the lists in the future, including adding or deleting line items, the mapping is retained.  If only values 
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have been changed in the lists, there is no need to reload the Default List.  If new line items have been 
added to the Default List, click the Populate Default Values button and map the newly added items.  
New list maps can be created by clicking the New Map button.  Navigate between maps by selecting the 
desired map from the drop-down menu. 

− List Select: Launches the Select List dialog.  Select the vendor list to toggle all assembly sub-items in the 
Estimating tab to that list.  Click the Update Job button located in the Update button group in the List 
tab to update all assembly sub-items connected properties with the values from the selected list.  You’re 
now ready to print the comparison report for the selected list. 

− Export Map: Exports the list map to the desktop.  You can now share the list map with other users, save 
as a backup, or create multiple list maps that you can import and use whenever needed.  With this 
capability, essentially there is no limit to the number of vendor lists that you can quickly compare for all 
of your projects. 

− Import Map: Imports the selected list map file. 

Template Tab 

Set Default Property: In this tab you can set and add default properties for all the standard takeoff tools, 
markup tools, job property and estimating folder items listed in the tab.  Launch an items dialog by clicking on its 
icon and make changes to existing properties or add new properties.  From this point on, the changes will be 
included each time a new instance of the item is created. 

Assembly Group: New assemblies can be created and added to assembly groups.  By default, 3 assembly groups 
are included (“Assembly Group 1”, “Assembly Group 2” & “Assembly Group 3”).  Assembly groups are displayed 
by clicking the Assembly Group drop-down menu at the top of the main assembly area and choosing the group 
that you would like to display.  Move an assembly group up or down in the list by selecting the assembly group 
and clicking either the up or down arrow to the right of the assembly group drop-down menu.  Rename or 
delete an assembly group by selecting it and clicking the Rename or Delete button to the right of the arrow 
buttons.  Click the Fill Property button to batch fill property values by selecting the property from the drop-
down menu, typing in the new value then selecting the appropriate items to update.  Click the Add Property 
button to batch add new properties to assemblies in the assembly group by selecting the new property type, 
select which items to add the new properties to then click the Property Details button to type in the property 
values or calculation formula.  Click the Delete Property button to batch delete properties from assemblies and 
or sub-items in the assembly group.  Click the Find button to search all items in the Template tab for the entered 
text in the selected item.  Click the Change Type button to change the assembly type between linear and 
segment.  Click the Delete button to delete multiple assemblies at one time.  Set the Reordering check box to 
allow items to be moved around tin the main Template area. 

Main Assembly Area: Property columns can be displayed in the main assembly area.  To adjust the column 
layout, click the Layout button at the top of the main assembly area.  In the Layout dialog, you can add property 
columns, delete columns, and change the order of the columns.  To add a property column, click the Add 
Column Name drop-down menu and choose the property to be displayed.  The drop-down menu displays all 
takeoff items and sub-item properties that exist in the Template and Estimating tab.  Column widths can be 
resized by placing the mouse at the header row column dividing line and when the arrow icon displays drag the 
column edge to adjust its width.  Click into a property value cell to change its value.   

Side Panel: The right side Templates side panel allows you to select an assembly group to be displayed in the 
side panel. 

Template Tools Button Group: The Template Tools button group located at the top of the Template tab 
contains the following buttons related to working with assemblies: 
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− New Folder: Adds a new folder to the selected assembly group for the purpose of organizing assemblies.  
When a folder is added it will be inserted below the last item in the main area.  Assemblies can be 
placed into folders by dragging the assembly below the folder.  To remove an assembly from a folder, 
drag it above the folder. 

− Delete: Deletes the selected assembly or folder including its contents. 
− Import Group: Imports an assembly group file that has been exported by another computer.  Double 

clicking on an assembly group file will automatically import the group. 
− Export Group: Exports an assembly group file that can be imported by another computer. 
− Expand All: Expands all folders, assemblies and sub-items in the main area so that all items are visible. 
− Collapse All: Collapses all folders and assemblies in the main area so that all sub-items become invisible. 

Clipboard Button Group: The Clipboard button group located at the top of the Template tab contains the 
following buttons related to copy and paste of folders and assemblies in the main template area: 

− Copy: Copies the selected assembly or folder and its contents to the clipboard. 
− Paste: Pastes the contents of the clipboard into the main template area. 

New Assembly Button Group: New assemblies can be created from the 4 standard takeoff tools (Area, Linear, 
Segment & Count) as well as the enhanced Joist and Beam tools.  The only difference between the standard 
takeoff tools and assemblies is that assemblies allow you to add sub-items which can optionally be connected to 
lists in the List tab.  If you will be using TradeTek in both imperial and metric measurement modes, it is 
recommended that you create separate assembly groups for each mode.  When TradeTek is in imperial mode, 
some inputs and labels in the dialogs will be imperial in metric assemblies instead of metric as you might expect.  
When TradeTek is toggled back to metric mode, those metric assemblies will go back to how they were when 
you created them. 

− Create New Standard Assembly: To create a new assembly, click the appropriate assembly type from 
the New Assembly button group to launch the new assembly dialog.  Name the assembly and click OK to 
add the assembly to the main template area.  For more information regarding the Info and Takeoff tabs, 
refer to the appropriate takeoff tool in the Takeoff Button Group section above.  A takeoff folder can be 
pre-set in the tool by typing the name of a folder to the right of Default Folder in the dialog.  If a folder 
by that name exists in the Estimating tab, the takeoff will be placed in that folder.  If the folder does not 
exist, one will be created. 

− Add Assembly Sub-Item: To add an assembly sub-item, either click on a new assembly button to create 
an assembly or double click on the icon of an existing assembly in the main template area to launch its 
dialog and click the Add Sub-Item button.  When the Name Tab dialog presents, name the new sub-item 
tab and click OK to add the new sub-item.  You are now in the Sub Item tab and will notice that your 
sub-item tab name is displayed in the sub-item drop-down menu.  You can add multiple sub-items to the 
assembly by clicking on the Add Sub-Item button from either the Info or Takeoff tabs.  You can also add 
sub-items to other sub-items by clicking on the Add Sub-Item button from the Sub Item tab.  The new 
sub-item will be added to the currently selected sub-item.  All sub-items can be accessed from the sub-
item drop-down menu in the Sub Item tab.  Sub-items to other sub-items are indicated in the drop 
down menu with * in front of the sub-item tab name.  Once a sub-item is added to an assembly, you can 
now input property values, add new properties and can also connect the sub-item to a list.  You can re-
name or delete assembly sub-items but selecting the appropriate sub-item tab name in the drop-down 
menu and clicking either the Rename or Delete buttons to the right.  Once multiple sub-items have been 
added, the order of the sub-items can be rearranged by clicking the Organize SubItem button located in 
the Info tab of the dialog.  To copy complete sub-items including all of their properties to the same 
assembly or to different assemblies, click the Copy To button at the top right corner of the dialog. 
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− Connect Sub-Item to List: To connect an assembly sub-item to a list, navigate to the Sub Item tab in the 
assembly dialog, select the appropriate sub-item tab name from the drop-down menu and click the 
Connect To List button.  When the Connect To List dialog presents, select the list and column that you 
want to connect to the Name property of the sub-item.  Once connected to a list, the Name property 
value becomes a drop-down menu that allows you to choose an item from the connect list column.  
Start typing characters in the name of the item that you are searching for to reduce the list size and find 
items faster.  If you choose the wrong item, delete that item from the name field to display the drop-
down menu again to choose from.  If a sub-item is connected to a list with multiple columns, the other 
columns of data for the item selected can be updated in the sub-item if their properties have been 
added.  For example, let’s say that we have a list with 2 columns (Item Name & Cost Each).  If you 
connect a sub-item to the “Item Name” column and add a number property to that sub-item called 
“Cost Each”, when you choose the sub-item Name property value from the “Item Name” drop-down 
menu, that items “Cost Each” value from the list will be updated in the “Cost Each” property of the sub-
item.  

− Presets: Presets allow you to create multiple versions of the assembly by predefining unique assembly 
and sub-item property values for each preset.  This eliminates the need to duplicate assemblies to 
create preset versions.  To add a preset to an assembly, from the Info tab click the Presets button.  To 
add a new preset entry, click the Add button at the bottom left corner of the dialog.  Enter the new 
preset name, which will be the assembly name when the preset is selected.  To add a default property 
value selection to a preset, click on the preset name to select it, then click the Add Default button.  To 
add an assembly sub-item custom (user added) property value set the Sub Item Custom Property radio 
button.  To add an assembly sub-item standard property value set the Sub Item Standard Property radio 
button.  To change the sub-item selection from list or name, set the Sub Item Name radio button.  To 
add an assembly custom property value set the Assembly Custom Property radio button and to add an 
assembly standard property value set the Assembly Standard Property radio button.  To define a list for 
the selected sub-item to be connected to set the Connected List radio button.  Set the remaining 
appropriate inputs for each entry, then click OK to add the entry.  Preset entries are added one at a time 
by clicking the Add Default button to complete each entry.  To use an assembly that has presets 
assigned, launch the assembly, select the desired preset from the list (the preset name becomes the 
assembly name) then perform the takeoff as usual. 

− Create New Joist Assembly: To create a new joist assembly, click the Joist assembly type from the New 
Assembly button group to launch the joist assembly dialog. The Info tab in the joist assembly is the 
same as an area assembly.  In addition to the takeoff measurements in the Takeoff tab of area 
assemblies, the joist assembly also has Total Joist Length as well as Joist Segment Count and Tallies.  
These measurements can be accessed in the quantity calculation formula of other properties and sub-
items in the assembly. 

In the Joist tab, enter the joist material description in the Joist Material input (something like 2x10 
SYP#2) or connect the generated joists to a list by clicking the Connect To List button and selecting the 
appropriate list name and column to connect to.  Choose the generated joist color, select your Length 
Calc preference and set the joist on-center spacing from the OC Spacing drop-down menu. 

When the Convert Short Lengths checkbox is checked, all generated joists shorter than 8’ will be figured 
out of longer material.  14’ joist sub-items will be generated for all 7’ long pieces, 10’ joist sub-items will 
be generated for all 5’ long pieces and 12’ joist sub-items will be generated for all 6’, 4’, 3’, 2’ and 1’ 
pieces.  The same applies when TradeTek is in metric mode.  When the Convert Short Lengths check box 
is checked, short joists are never generated to the Nearest Even Foot.  You can turn the joist length 
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labels on or off, add a joist waste percentage that will get added to all of your generated joist quantities 
and can also set checkboxes to add joists at each end of each joist area or add double joists. 

Joists are assembly sub-items that get generated on the fly.  Any properties that you add in the Joist tab 
will be included in all generated joists from that joist assembly.  If connected to a list, the value of any 
joist sub-item properties that match a column name in a connected list will be updated from the list. 

To use a joist assembly, launch it from the Templates side panel, and draw the appropriate joist area(s).  
Double click in a joist area to present the Joist/Rafter Tool dialog.  Here, you can draw new joists or 
rafters, clear the joists or rafters in the selected area or regenerate the joist totals.  To draw joists, click 
the beginning and second point of the reference line to locate the first joist.  After the second point is 
clicked, the remaining joists for the joist area will be drawn in and the appropriate joist sub-items will be 
generated.  To adjust an individual joist, double click on the joist line to present the Edit Joist dialog.  
The dialog displays the actual length of the joists (not including the joist depth that gets added to rafters 
to account for the angle cut).  You can move or resize the joists with the arrow keys (hold down the Shift 
key for faster movements), delete the joist or duplicate the joist.  Any time that you manually adjust an 
individual joist, be sure to double click in the joist area to re-launch the Joist/Rafter Tool and click the 
Regenerate Totals button. 

If the joist assembly is connected to a list, when the joist sub-items are generated, the List Map dialog 
will present that shows the generated joist length and allows you to pick the appropriate item from the 
connected list by clicking in the List Value column and choosing the item from the list.  Once the list has 
been presented, type in the search box at the top of the list to narrow the search.  Once all presented 
joist lengths have been selected, click OK to proceed with generating the joists.  Once you have made a 
list selection for a joist length, that selection will be stored in memory and automatically applied to any 
future joists that get generated of the same length from that assembly. 

− Create New Beam Assembly: To create a new beam assembly, click the Beam assembly type from the 
New Assembly button group to launch the joist assembly dialog.  The Info tab in the beam assembly is 
the same as the segment assembly.  In addition to the takeoff measurements in the Takeoff tab of 
segment assemblies, the beam assembly also has Total Beam Length as well as Beam Segment Count 
and Total Beam Material LF and Tallies.  These measurements can be accessed in the quantity 
calculation formula of other properties and sub-items in the assembly. 

− In the Beam tab, enter the joist material description in the Beam Material input (something like 2x10 
SYP#2) or connect the generated beams to a list by clicking the Connect To List button and selecting the 
appropriate list name and column to connect to.  Select your Length Calc preference, set the number or 
beam Plies (layers of material) and optionally add a bearing value.  If Bearing is set to 6”, then 6” will be 
added to each end of your beam segment takeoffs (so you would need to do your takeoff from the 
inside of the opening on one side to the inside of the opening on the other side). 

When the Convert Short Lengths checkbox is checked, all generated beams shorter than 8’ will be 
figured out of longer material.  14’ beam sub-items will be generated for all 7’ long pieces, 10’ beam 
sub-items will be generated for all 5’ long pieces and 12’ beam sub-items will be generated for all 6’, 4’, 
3’, 2’ and 1’ pieces.  The same applies when TradeTek is in metric mode.  When the Convert Short 
Lengths check box is checked, short beams are never generated to the Nearest Even Foot. 

Beams are assembly sub-items that get generated on the fly.  Any properties that you add in the Beam 
tab will be included in all generated beams from that beam assembly.  If connected to a list, the value of 
any beam sub-item properties that match a column name in a connected list will be updated from the 
list. 
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To use a beam assembly, launch it from the Templates side panel, and draw the appropriate segment 
takeoffs.  Double click on an individual beam segment to present the Beam Tool dialog, where you can 
view the actual beam length, regenerate totals, or make a list map adjustment if the assembly is 
connected to a list.  To adjust the length of a beam segment, click on it to make the end points visible, 
then click and drag a point to adjust the length.  Any time you adjust the length of a beam segment, be 
sure to click the Regenerate Totals button. 

If the beam assembly is connected to a list, when the beam sub-items are generated, the List Map dialog 
will present that shows the generated beam length and allows you to pick the appropriate item from the 
connected list by clicking in the List Value column and choosing the item from the list.  Once the list has 
been presented, type in the search box at the top of the list to narrow the search.  Once all presented 
beam lengths have been selected, click OK to proceed with generating the beams.  Once you have made 
a list selection for a beam length, that selection will be stored in memory and automatically applied to 
any future beams that get generated of the same length from that assembly. 

− Create New Panel Assembly: To create a new panel assembly, click the Panel assembly type from the 
New Assembly button group to launch the panel assembly dialog, name the assembly, then click OK to 
add it to the Assembly Group.   
The following inputs are found under the Info tab: 

o Name: Type in the name of the panel takeoff. 
o Panel/Roll: Select for the assembly to be in either Panel or Roll mode. 
o Trim: If the assembly is in Panel mode, set the Trim check box to put the assembly in Trim 

mode. 
o Units: Change the quantity value units. 
o Color:  This is the color of the takeoff item on the page.  Colors are selected randomly by default 

but can be changed by the user here. 
o Texture: To display a directional texture for each Panel or Roll piece, set the Texture check box. 
o Width: Set the Panel or Roll width in feet or Trim width in inches. 
o Length: Set the Panel, Roll or Trim width in feet. 
o Add Property:  Add up to 10 custom properties in the Info tab. 
o Refresh: The refresh button will refresh the values of all properties when changes have been 

made. 
o Folder:  If a takeoff folder(s) has been added in the Estimating tab, a folder can be selected from 

the drop-down list for the takeoff item to be placed into.  A takeoff folder can be pre-set in the 
tool by typing the name of a folder to the right of Default Folder in the dialog.  If a folder by that 
name exists in the Estimating tab, the takeoff will be placed in that folder.  If the folder does not 
exist, one will be created. 

The following inputs are found under the Takeoff tab in Panel mode: 
o Area: Displays the area measurement of all combined panel pieces, not including scrapped 

pieces. 
o Piece Count: Displays the total number of panel pieces. 
o Point Count: Displays the total number of panels. 
o Batten Linear: Displays the total linear measurement of all batten strips. 
o Perimeter Points: Displays the total number of perimeter points of all panel pieces. 
o Perimeter Linear: Displays the total perimeter linear measurement of all panel pieces. 
o Batten Strip: Set the checkbox to turn batten strips on. 
o Batten OC: If Batten Strip is checked, set the on center spacing. 

The following inputs are found under the Takeoff tab in Panel mode with Trim checkbox checked: 
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o Point Count: Displays the total number of trim panels. 
o Piece Count: Displays the total number of trim panel pieces. 
o Linear: Displays the total liner measurement of all trim pieces. 

The following inputs are found under the Takeoff tab in Roll mode: 

o Point Count: Displays the total number of rolls. 
o Piece Count: Displays the total number of roll pieces. 
o Area: Displays the total area measurement of all roll pieces. 
o Seam Linear: Displays the total linear measurement of all seams. 
o Perimeter Points: Displays the total number of perimeter points of all roll pieces. 
o Perimeter Linear: Displays the total perimeter linear measurement of all roll pieces. 

Adding sub-items to a panel assembly works the same way as adding them to all other assembly types 
(see Add Assembly Sub-Item) above. 

− Panel/Trim Mode Takeoff: Launch the Panel assembly and click to add a panel to the page.  Drag the 
panel to the desired location on the page.  To cut or modify a panel piece, double click on the panel 
piece to display the Panel and Roll Tools dialog with the following buttons: 

o Horizontal Cut: To make a horizontal cut click the button and then click the location of the cut. 
o Vertical Cut: To make a vertical cut click the button and then click the location of the cut. 
o Angle Cut: To make an angle cut click the button and then click the first point of the angle 

somewhere inside of the panel, draw the angle line and then click the second point somewhere 
inside of the panel. 

o Corner Cut: To make a corner cut click the button and then click the first point at the inside 
corner location of the cut, then click the second point towards the outside corner of the cut. 

o Trace Cut: To cut an irregular shape click the button and then click the first point somewhere 
near the edge of the panel, draw the irregular line and then click the final point near the edge of 
the panel. 

o Inside Cut Out: To make an inside cutout, click the button then click the first point, draw around 
the perimeter of the cutout area and then click the final point close to the first point. 

o Undo Action: Click the button to undo the previous action in the dialog. 
o Align Corners: When this check box is checked, when a panel, trim or roll piece is dragged close 

to another piece it will snap into place against that piece. 
o Rotate 45 Left: Rotates the piece 45 degrees to the left. 
o Rotate 45 Right: Rotates the piece 45 degrees to the right. 
o Rotate 90 Left: Rotates the piece 90 degrees to the left. 
o Rotate 90 Right: Rotates the piece 90 degrees to the right. 
o Rotate 180: Rotates the piece 180 degrees. 
o Arrow Key Rotation: Rotates the piece by tapping the Arrow keys.  Hold down the Shift key for 

faster movement. 
o No Rotation: Resets the piece to its original orientation. 
o Delete Panel: Deletes the panel along with all its associated pieces. 
o Delete Takeoff: Deletes the entire assembly including all panels and pieces. 
o Scrap This Piece: Scraps the selected piece and deducts its associated takeoff measurements 

(does not reduce panel count). 
o Move To Page: To move the piece to a different page, click the button, navigate to a different 

page and then click somewhere on the page. 

The additional buttons below are visible when in Roll mode: 
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o Add Seams: Click the button, then draw the linear takeoff at all seam areas. 
o Delete Seams: Click the button, then click on a seam line to delete it. 

 
− Create New Manual Assembly:    To create a new manual assembly, click the Manual assembly type 

from the New Assembly button group to launch the manual assembly dialog, name the assembly, then 
click OK to add it to the Assembly Group.  

Manual assemblies can be created and used for adding items to the job that do not require a takeoff to 
generate the item quantities (quantities are already known).  For more information regarding adding 
sub-items and properties to Manual assemblies, see the Create New Standard Assembly section above.  
A takeoff folder can be pre-set in the tool by typing the name of a folder to the right of Default Folder in 
the dialog.  If a folder by that name exists in the Estimating tab, the takeoff will be placed in that folder.  
If the folder does not exist, one will be created. 

− Batch Buttons: The Batch buttons allow bulk property changes to be made to assemblies in the 
Template tab. 

o Fill Property:  Select the property from the drop-down list to edit, then type in a value in the 
Value field.  Once executed, all the existing properties in the currently selected assembly group 
will be updated.  To update properties in all assembly groups, check the All Assembly Groups 
check box.  Select the desired assemblies to be updated or click the Select All button to update 
all assemblies in the group. 

o Add Property:  Set the appropriate new property type radio button.  Set the appropriate Apply 
To radio button.  Click the Property Details button to create and set up the new property.  Once 
executed, the new property will be added to all assemblies in the currently selected assembly 
group.  To update properties in all assembly groups, check the All Assembly Groups check box.  
Select the desired assemblies to be updated or click the Select All button to update all 
assemblies in the group. 

o Delete Property:  Choose the appropriate property to be deleted from the drop-down menu.  
Set the appropriate Apply To radio button.  Once executed, the property will be deleted from all 
assemblies in the currently selected assembly group.  To delete the property in all assembly 
groups, check the All Assembly Groups check box.  Select the desired assemblies to be updated 
or click the Select All button to update all assemblies in the group. 

o Change Type:  Allows you to change a linear assembly to a segment assembly or a segment 
assembly to a linear assembly (set the appropriate radio button).  Once executed, the property 
will be changed in all assemblies in the currently selected assembly group.  To change the 
property in all assembly groups, check the All Assembly Groups check box.  Select the desired 
assemblies to be updated or click the Select All button to update all assemblies in the group. 

Report Tab 

Reports can be created that will organize and display takeoff data from the Estimating tab with multiple export 
options.   

Left Side Panel 

The left side Report Files panel is where all created report files are located.  Click on the report name to display 
the report in the main area. 

The Report Files side panel contains 8 report related buttons: 
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− Add Report: Click this button to create a new report file.  In the Name Report dialog, give the report a 
name and then click OK to create the report. 

− Clone Report: To clone (make a copy) of an existing report, select the report in the Report Files side 
panel then click the Clone Report button.  Name the cloned report, then click OK to create the new 
report. 

− Property: To rename an existing report, select the report in the Report Files side panel then click the 
Property button.  Rename the report, then click OK to save the change. 

− Delete: To delete an existing report file, select the report in the Report Files side panel then click the 
Delete button. 

− Import Report: To import a report file that has been exported from another computer, click the Import 
Report button, navigate to and select the report file to be imported, then follow the prompts.  Double 
clicking on the report file will automatically import it. 

− Export Report: To export a report file to be imported by another computer, select the report in the 
Report Files side panel then click the Export Report button and follow the prompts. 

− Up: To reposition a report in the side panel list by moving it up one row, click the Up button. 
− Down: To reposition a report in the side panel list by moving it down one row, click the Down button. 

Build Tab 

Select a report in the Report Files side panel then click the Build tab at the top of the main area to display the 
selected report.  The Build tab is where the report layout is created.  New report layouts are initially created 
with 5 columns and 20 rows, these numbers can be adjusted as needed. 

Most reports will consist of a header area, group area (where job data is displayed) and summary area on the 
last page.  It’s best to think about laying out reports from the top down.  Set your column widths based on the 
job data that will be displayed in each column, then create your report header with any logos, images, text 
labels, address display area or any other company information.  Once the header is complete, then add the 
group body (with optional page footer) and then add any sub-totals or totals in the summary area. 

Right Side Panel 

The right side Report Tools panel is where all report tools are located that are used to construct report layouts.  
Check the Zoom In check box at the top right corner of the side panel to increase the zoom level of the report 
page.  The Report Tools panel contains that following tool groups: 

− Page Setup: Set the page size by selecting a pre-defined size from the drop-down menu or select Inches 
or MM then enter a custom page width and height in the W and H inputs.  Set the page margins, 
orientation and change the number of columns and rows in the layout. 

− Cell Property: Set the selected cell format, fill color, text color, cell borders, text type, size and 
formatting, vertical and horizontal justification, add an image, merge cells and row and column width 
adjustment (hold down the Shift key for faster adjustment).  Check the Resize All Cells check box to 
change all row and column widths at the same time. 

o Add Image: To add a report image, select the top left cell of the desired image location and 
select the appropriate image from the Report Images library.  Report images must be added to 
the Report Images library before they can be added to a report. 

− Group Box Items:  
o Group Button: The Group button launches the Report Group dialog.  A report must have at least 

a level 1 group defined and can optionally have up to 3 nested levels of grouping.  Report items 
are grouped based on property values that exist in each line item in the report.  For example, if 
you want to create a report that is grouped by building, level, and room, the first step is to be 
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sure that all items that will appear in the report from the Estimating tab have “Building”, “Level” 
and “Room” properties added with the appropriate values.  Next, at the top right corner of the 
Report Group dialog, start with the Level 1 Property drop-down menu to select the top level  
they must first be added to either an assembly in the Template tab or to one of the takeoff tools 
in the Set Default Property tab of the Template tab.  In our example above, the level 1 group 
property would be the “Building” property, the level 2 group property would be the “Level”  
property and the level 3 group property would be the “Room” property. 
 
By default, the level 1, 2 and 3 labels will display the group instance names at the top of each 
group.  For the example given above, the display format would be Building – Level – Room.  It’s 
also possible to add text to the left or right of [PropertyValue] at each level’s label or replace it 
all with text.   
 
To the right of each Property drop-down menu is its Filter button.  Property filters allow you to 
choose the property values that will be displayed in the group.  Using the above example, the 
“Building” property may have multiple values like “Building 1”, “Building 2” and “Building 3”.  
Likewise, the “Level” property may have values like “Level 1”, “Level 2” and “Roof” and the 
“Room” property may have values like “Kitchen”, “Living Room” and “Dining Room”.  Click the 
Filter button to the right of each Property drop-down menu and check all the property values 
that you would like to be included in the report.  If the Auto Alphabetize checkbox is checked, 
all report group values will always be automatically alphabetized in the report.  If the Auto 
Select All checkbox is checked, all existing report group values will always be automatically 
selected. 
 
The report group area consists of a group header, group body and optional group footer.  All 
information inside of the group area is included in each generated instance of the groups in the 
report.  In the Header Rows drop-down menu, choose the total number of rows to be included 
in the header area.  To the right of the Header Rows menu in the Data Row drop-down menu, 
choose the relative header row number that the group instance property label will be displayed 
in.  You can also add cell formatting, formatted text or reference property values in any open 
cells in the group header. 
 
In the Body Rows drop-down menu, choose the total number of rows to be included in the body 
area.  Typically, this will be set to 1.  To the right of the Body Rows menu in the Data Row drop-
down menu, choose the relative body row number that the data will be displayed in.  You can 
also add cell formatting, formatted text or reference property values in any open cells in the 
group body. 
 
In the Column Property area of the dialog, select a report column from the Column drop-down 
menu and then select the Property to be displayed in that column in the group body.  For 
example, you might choose column 1 and select the “Name” property, then select column 2 and 
select the “Qty” property.  In this example, the “Name” property values for all items in the 
report will be displayed in column 1 and the “Qty” property values for all items in the report will 
be displayed in column 2. 
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The group area can optionally include a group footer.  In the Footer Rows drop-down menu, 
choose the total number of rows to be included in the group footer.  If a group footer is not 
desired, set the Footer Rows to 0.   
 
In the Start Row drop-down menu, choose the starting row in the report for the group area. 
 
If the Consolidate Quantities check box is checked, the quantities of all like items will be 
combined.  In order for items to be consolidated, all property values in the report body columns 
displaying text properties must be identical. 
 
If the Roundup Quantities check box is checked, all quantity values displayed in the “Qty” 
column will be rounded up to the nearest whole number. 
 
If the Hide Group check box is checked, all group areas will be hidden in the View tab of the 
report. 
 
Group body row numbering can optionally be added.  Row numbers will be displayed in column 
1 and the column cannot be used to display any additional data (the first available data column 
will be column 2).  If group body row numbering is desired, in the Column 1 Row # area of the 
dialog, select either the Per Group or Per Report radio button.  If Per Group is selected, the 
group body numbering will start back over at 1 in each report group instance.  If Per Report is 
selected, the group body numbering will run continuously through all group instances of the 
report.  
 
Horizontal group body calculations can optionally be added in a column.  For example, if the 
“Qty” property values are displayed in column 2 and the “Cost Each” property values are 
displayed in column 3, you may want to set up an “Extended Cost” horizontal calculation to be  
down menu choose the column where the calculated values will be displayed.  In the Select 
drop-down menu choose a property value to be inserted into the calculation formula and click 
the operator buttons to insert an operator into the formula.  In the example mentioned above, 
the horizontal calculation formula might be {Qty} * {Cost Each}. 
 
Group footers can optionally include group sub-totals.  In the Footer Subtotals area of the dialog 
in the Column and Row drop-down menus, choose the column and relative footer row where 
the calculated sub-totals will be displayed.  Set the Include SubTotal check box to display sub-
totals and un-check to hide them. 
 
Group items can be displayed in alphabetical order by checking the Alphabetize By Column 
check box and selecting the appropriate column number. 
 

o Filter Button:  The Filter button launches the Filter Group Body dialog.  In the Filter Group Body 
dialog, you can enter conditional statements that when evaluated to true will filter that item out 
of reports.  For example, it’s common to want all sub-items of an assembly to display in a 
material report, but not the assembly itself.  To accomplish this, you could add a text property 
to your assemblies called “Filter” with a value of “Yes”.  Now you can add the filter “Filter=Yes” 
in the Filter Group Body dialog and all your assemblies will now be filtered out of the report.   
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To add a conditional statement, choose a property name from the Name drop-down menu.  
Remember, in order for a property name to be available in the menu it must exist either in an 
assembly or assembly sub-item or in one of the takeoff tools in the Set Default Property tab.  
Next, click on one of the operator buttons to add to the statement (=, <>, <, >), in the Property 
Value input type the property value that will evaluate to a true statement, then click the Add 
button at the bottom left corner of the dialog to add the conditional statement then click OK to 
close the dialog.  To delete a conditional statement, select the checkbox to the left then click the 
Delete button. 
 

o Prop Value Ref Button:  The Prop Value Ref button launches the Property Value Reference 
dialog.  This will allow you to display the value of a property in the group header, body or footer.  
Set the appropriate Group Section radio button.  In the Column and Row drop-down menus, 
select the relative group body, header or footer column and row where the value is to be 
displayed and optionally add prefix or suffix text to be displayed before or after the property 
value.  Click the Add button to add the property value reference to the cell.  To clear the cell 
select it, click the Prop Value Ref button, and then click the Delete button.  Keep in mind, when 
adding a property value reference to a group header or footer, the property value for all items 
within that group should be the same. 
 

− Page Items:  Page items can be added above or below the group body area (not within the group body).  
To display an address from the Address Book, click the top left starting cell and then click the Address 
button.  Displaying an address requires 4 available rows.  You can optionally add a page footer that will 
be displayed at the bottom of all PDF reports by clicking the Page Footer button and selecting the 
desired number of page footer rows.  Any page items that are added to the page footer will be displayed 
at the bottom of each page in PDF reports.  Select a cell and then click the Date, Time, Page #, Total 
Pages, Page # of Total Pages #, User, Job Name or Job Note display those values in the selected cell.  To 
add text to a cell, click the Text button and type the desired text into the Page Item Text dialog.  To add 
a formula to a cell that will display a calculated value, select the appropriate cell, then click the Formula 
button.  Click the Select Function drop-down menu to add a value to the equation and click the operator 
buttons to add an operator to the equation.  If the report has generated sub-totals, all sub-total 
instances are individually available to choose from.   
 
For example, If the report has only 1 level of grouping by “Building”, the available sub-total functions will 
look like {SubTotal,Col,Row,Building 1} and {SubTotal,Col,Row,Building 2}.  Once you have added the 
appropriate sub-total to the formula, replace the Col and Row inputs with the relative group footer 
column and row numbers where the sub-total is displayed in the group body.  The column and row 
numbers must match the input used in the Group button at the Footer SubTotals area.  Select the {All 
SubTotals (column number)} function to reference the sum of all generated sub-total instances in that 
column.  To reference the value of an individual cell, select the {Column,Row} function. 
The Connectors button will allow you to grab a calculated value from one report and display it in 
another report.  While in the report that the shared value is coming from, in the Outputs tab, double 
click in the Shared Name column and type a name that the value will be stored under.  Set the column 
number and row number where the shared source value is located.  While in the report that the shared 
value is to be displayed, from the Inputs tab, click in the first available Click to Assign Report row.  In the 
Select Report drop-down menu, choose the source report where the value is coming from, then from 
the Select Name drop-down menu, choose the name of the value to be displayed.  Set the column and 
row number of the desired cell that the value will be displayed in, then click OK to dismiss the dialog.  
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Connected report values can also be stored as Global Properties that can then be referenced in 
formulas throughout the software.  First, create a global property by clicking the Global Properties 
button in the Report Actions button group in the Report tab and typing in a property name.  Leave its 
property value blank and then click the OK button to save and dismiss the dialog.  Next, when creating 
an input or output connector, type the name of the variable that you added as a global property with 
“GBL:” in front of the property name.  For example, if you create a global property called “Bid Total” that 
you want to store a connected report value in you would need to name the input or output connector 
“GBL:Bid Total”.  With report connectors, each time a report is generated the newly generated value is 
re-saved updating the value in all appropriate areas.  Because of this, depending on how connected 
values are used it may be necessary to generate reports in a specific order to ensure that all associated 
values are updated correctly. 

− View As:  Set the View As radio button to either Excel, CSV or PDF depending on how you want to 
export the report.  In the View tab, you see a preview of what the report will look like when exported to 
the selected format.  Keep in mind that csv files store unformatted data only.  When a report is exported 
to Excel, TradeTek does not break the report into pages but rather exports a continuous report into the 
spreadsheet.  Once you have exported to Excel, you can at that point break the report into pages if 
desired.  If you are using a 4K monitor, you may need to adjust the scale in Excel to fit the page size.  To 
adjust the scale, go to the Page Layout tab in Excel and in the Scale to Fit button group adjust the scale 
appropriately.  Report page footers are only included in reports that are exported to pdf. 

Report Actions Button Group 

The Report Actions button group contains the following buttons related to report actions: 

− Address Book:  The Address Book stores a list of contacts that can be displayed in reports.  To add a 
new contact, click the Add button and enter up to 4 lines of text for each contact.  The selected contact 
will be displayed in one column of the report in 4 contiguous rows. 

− Export Excel:  From the View tab, click this button to export the selected report into an Excel 
spreadsheet.  Before exporting to Excel, Macros must be enabled.  In Windows, perform the following 
steps ensure the Macros are enabled: 

1. Launch Microsoft Excel and open a blank workbook. 
2. From the File menu on the left, scroll down and click on Options. 
3. Select Trust Center and then click on Trust Center Settings. 
4. Select Macro Settings panel and click the Enable All Macros radio button. 
5. Select Trusted Locations panel and set the Allow Trusted Locations checkbox. 
6. Click OK twice to close the Trust Center.  Now quit Excel. 

On macOS, perform the following steps to ensure that Macros are enabled: 
1. Launch Excel and select Preferences from the Excel menu. 
2. On the Security panel, set Enable All Macros and then quit Excel. 
3. If the settings fail to take effect the first time, repeat steps 1 and 2. 

When the report is exported to Excel, a copy is automatically saved to your desktop. 
− Export CSV:  From the View tab, click this button to export the selected report into a CSV file (no 

formatting is retained).  When the report is exported to CSV, a copy is automatically saved to your 
desktop. 

− Export PDF:  From the View tab, click this button to export the selected report into a PDF file.  When the 
report is exported to PDF, a copy is automatically saved to your desktop. 
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− Copy CSV:  From the View tab, click this button to copy the data from a CSV report into the clipboard.  
This will most often be used in conjunction with integration plugins that send takeoff data from 
TradeTek to another application. 

− Report Images:  Launches the Report Images dialog.  All images that will be used as a report image must 
be added here in the report images library first.  Click the Add button to launch the Image Editor dialog 
and add a new report image.  In addition to adding single images, the Image Editor dialog allows you to 
construct a logo with an optional foreground and background images, border formatting, background fill 
color and up to 4 separate lines of text.  When the Image Editor dialog is launched, a sample logo is 
displayed with a background fill color, border edge formatting and 4 lines of text.  The Image Editor 
dialog contains the following inputs: 

o At the W x H in Inches input, set the overall width and height of the image or logo.   
o If a background fill color is desired, check the Fill Color check box, then choose the color from 

the color box. 
o If an image or logo border is desired, choose the appropriate border from the Border drop-

down menu then choose the border color from the color box. 
o Choose the desired overall image or logo transparency from the Transparency drop-down 

menu. 
o To add a Background Image click the Select button to select the image and then set the Top and 

Left positions in inches.  Then, set the Width and Height of the image.  To delete a background 
image, click the Delete button. 

o To add a Foreground Image click the Select button to select the image and then set the Top and 
Left positions in inches.  Then, set the Width and Height of the image.  To delete a background 
image, click the Delete button. 

o Optionally add up to 4 lines of text.  Set the text line 1, 2, 3 or 4 radio button to adjust that line 
of text’s Top and Left positions, font style and size, font color, vertical orientation, and font 
formatting. 

o To simply add a single image, add it as foreground or background image. 

Store Tab 

Welcome to the TradeTek store.  Here you can purchase or download free plugins or bundles.  Plugins are 
typically applications that create an integration between TradeTek and another application.  Bundles are groups 
of lists, reports and assembly groups that have been configured to work for a specific trade group.  In the left 
side column, you’ll see a list of plugins (add-ons) and bundles that have been developed either by a 3rd party 
developer or by TradeTek.  Some plugins or bundles may be free to download, and some may be purchased 
either directly from the plugin store or from a 3rd party developer’s website.  Click on a plugin or bundle in the 
left side panel to view details and to purchase and / or download. 

As a user, you can create a bundle containing assembly groups, lists and reports to share with other users for 
free or to sell in the TradeTek store. 

Bundles Button Group: The Bundles button group located at the top left of the Plugin tab contains the following 
buttons related to bundles: 

− Build Bundle: Click the Build Bundle button to launch the Build Bundle dialog.  Up to 20 bundles can be 
installed in TradeTek at one time.  To create a new bundle, select the first available slot.  Complete the 
following steps to generate your bundle file: 

o Step 1: Name the bundle and add the version number.  To delete a bundle, click the Delete 
button. 
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o Step 2: You can either distribute your bundle for free or apply a lifetime license to it.  To 
distribute it for free, set the Free to Use radio button.  To apply a lifetime license, set the 
Lifetime radio button and select the ticket file and security code received from Excel Software 
(licensing company).  For more information on how to set up licensing and sell your bundles in 
the TradeTek store, see the API Guide in the Developer Help button group of the Help tab. 

o Step 3: Set the appropriate check boxes for the folder properties, assembly groups, lists and 
reports to be included in the bundle.  Keep in mind that when folder properties are added, 
unique tags are created that identify those folders to the software (rather than the folder 
names) so simply re-naming a folder property does not change how the software references 
that property.  Re-naming a folder property does not change its unique tag. 

o Step 4: Enter the bundle details that will be displayed when a bundle is installed or sold in the 
TradeTek store.  Add an optional left and right side description.  If you will be distributing the 
bundle in the store, add a bundle icon image.  Add the required vendor information (Contact, 
Phone Number and email address) and an optional website url.  Optionally select a user guide 
pdf file or enter a url to a pdf file.  Optionally add a user guide video url. 

Click the Build button to create your bundle file.  The file will be saved to your desktop and can now be 
imported into TradeTek by clicking the Manage Bundle button. 

− Manage Bundle: Click the Manage Bundle button to launch the Select Bundle dialog.  Navigate to and 
select the appropriate bundle file (file with extension .ttbundle).  From the Manage Bundle dialog, click 
the Import button to import a bundle.  Click the Details button to view the details of a bundle.  For a 
licensed bundle, click the License Options button to view your license information, release or restore 
your license or perform a remote reset.  For a licensed bundle, click the License Reset button to reset 
the license using a reset code provided to you by Excel Software (licensing company). 

To submit your bundle to the TradeTek store, refer to the Store Upload section of the Developer Guide 
for instructions. 

Manage Plugins Group: Click the Import button to import a plugin file.  Click the Remove button to remove an 
installed plugin.  Click the Details button to view the details of all installed plugins. 

Installed Plugins Group: Displays all installed plugins. 

TradeTek’s easy to use API makes it simple for developers to create plugins to set up integrations between 
TradeTek and other software applications or create custom functionality within the software.  For more 
information regarding developing plugins, in the Help tab in the Developer Help button group, you’ll find the API 
Guide along with some developer help videos that explains how to access and utilize the API and how to create 
internal plugins or external applications that can access the API. 

If you have an idea for a plugin that you would like to see developed, let us know by clicking the Help tab then 
clicking the Feedback button. 

Help Tab 

In the main area of the Help tab, you’ll find our company contact information, a link to the TradeTek website, a 
link to some frequently asked questions and the TradeTek system requirements. 

General Button Group: The General button group located at the top of the Help tab contains the following 
buttons related to general functions: 
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− Feedback: Click the Feedback button to ask us a question, make a suggestion or report a bug.  We will 
make every effort to respond within 24 hours. 

− Download: Click the Download button to download the document that is displayed in the main area at 
the time. 

− Check For Update: Click to check for software updates to ensure that you are running the latest version 
of TradeTek. 

User Help Button Group: The User Help button group located at the top of the Help tab contains the following 
buttons related to user help resources: 

− Takeoff Basics: Click to display a short textbook for beginners that explains the advantages of utilizing 
modern takeoff and estimating software. 

− User Guide: Click to display the TradeTek user guide.  Click the Download button to download a PDF 
copy of the user guide. 

− Training Videos: Click to access the training video library.  Choose a category in the Category column to 
display the list of related videos in the Video column, then click the desired video to play it.  By default, 
all videos will play in the main area of the Help tab and may be smaller than you would like.  To play all 
videos in your default web browser instead of within TradeTek, from the Preferences located in the File 
drop-down menu check the Play Videos in Default Web Browser check box. 

− Screen Share: This button is used to initiate a zoom screen share for technical support or training with 
TradeTek Software.  While on the phone with a TradeTek support representative, enter the meeting 
name provided to start the screen share session. 

− File Share: This button delivers uploaded files using temporary cloud storage to anyone with a web 
browser.  Once files are uploaded, a token number as well as a url link is provided to access the 
uploaded file. 

Developer Help Button Group: The Developer Help button group located at the top of the Help tab contains the 
following buttons related to developer help resources: 

− API Guide: Click to display the API user guide.  Click the Download button to download a PDF copy of 
the API Guide. 

− Developer Videos: click to access the developer video library.  Choose a category in the Category 
column to display the list of related videos in the Video column, then click the desired video to play it.  
By default, all videos will play in the main area of the Help tab and may be smaller than you would like.  
To play all videos in your default web browser instead of within TradeTek, from the Preferences located 
in the File drop-down menu check the Play Videos in Default Web Browser check box. 

Developer Tab 

By default, the Developer tab is deactivated.  To activate the Developer tab, from the Preferences dialog 
located in the File drop-down menu check the Developer check box.  The API check box must also be checked to 
turn on the application API. 

For more information, see the API Guide in the Developer Help button group of the Help tab. 

TradeTek Cloud 

Cloud Setup: To access the TradeTek Cloud Setup dialog, click File at the top left, click Preference then click the 
TradeTek Cloud button.  The cloud setup dialog is typically accessed by the person designated as the TradeTek 
administrator for the company.  All other users will access cloud via the portal dialog which is mentioned in 
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more detail below.  The setup dialog allows the admin to add users, create and upload preference bundles, 
adjust company settings, create new job entries, upload and manage database lists, create and manage budgets, 
create and manage invoices, create and manage company contacts, post messages and view activity logs. 

When logging into the cloud account for the first time, click the Connect in the TradeTek Cloud Setup dialog.  
You can disconnect from the cloud account at any time by clicking the Disconnect button.  An admin can login to 
multiple cloud accounts and then easily switch between them by logging out, then selecting the appropriate 
account from the drop-down menu to login to.  To allow an external application that has been integrated with 
TradeTek via the Cloud API to connect, click the Cloud API button to generate an App Key.  The Cloud API 
checkbox must also be checked in the Preference dialog to turn Cloud API on.  For more information, from the 
Developer tab click the Cloud API button then click the Cloud API Help button.  The Delete Cloud button will 
delete your entire cloud account.  To create a backup of your entire cloud account on your local computer, click 
the Backup Cloud button.  A Scheduled Backup dialog will appear allowing you to set parameters for scheduled 
backups and choose the folder location on your local computer where the backup files will be stored.  You can 
restore your cloud account from a previous backup by clicking the Restore Cloud button.  When a user sends 
data to the cloud, a temporary lock is set before the updated process and is cleared when completed to ensure 
data integrity.  In the event of a hardware failure, internet outage or software issue during the upload process, 
that lock may remain set.  To clear the lock and regain control of TradeTek Cloud, click the Clear Lock button.  
It’s important to ensure that no users are attempting to upload data to the cloud during the override process, as 
this could result in data loss.  Although TradeTek maintains backups of all cloud accounts, you can create a fast 
backup of your entire cloud account to the server at any time by clicking the Hot Backup button.  The label at 
the bottom of the setup dialog shows the number of jobs, users and items per job allowed with your current 
cloud subscription account.  If you have upgraded your cloud subscription, click the Refresh Limits button to see 
the upgraded limits.  The Cloud Setup dialog contains the following tabs: 

− Users: Add, edit or delete users in the cloud account.  To add a new user, click the Add button.  Enter 
the username and a password for their login credentials.  Choose the authentication type from the drop-
down menu.  To authenticate by computer which does not require a password to be entered, from the 
File menu click Preference then click on the User Name in blue.  The authentication code will be 
displayed and saved to the clipboard.  Navigate back to the cloud setup dialog and paste the 
authentication code in for Computer 1.  The same process can be repeated to authenticate a second 
computer for the user.  Adjust the Default Job Permissions as needed for the user then click OK to add 
the new user.  To edit an existing user. Click on the username to select it and then click the Edit or 
Delete button.  To alphabetize the user list, click the Alphabetize button. 

− Preferences: Preference bundles can be created and access granted to the appropriate users.  Click the 
Add button to create a new preference bundle entry.  Name the preference bundle and assign the 
appropriate users.  Once a new preferences bundle entry has been created, items can be added to the 
bundle from the cloud portal dialog (see Cloud Portal section below). 

− Settings: Enter the company contact information that can be displayed on invoices and budgets.  If you 
would like to use email sending features within TradeTek, enter the email server information.  In order 
to link a gmail or yahoo account to TradeTek, start by defining an App Specific password within your 
Gmail or Yahoo account.  That is the password that must be used in the Email Server setup process, NOT 
the password used to log into your Gmail or Yahoo account.  Optionally add a company logo image to be 
displayed on invoices and budgets.  Set a default selection for the assigned user and other users that will 
automatically get assigned to all new items. To save the settings to the cloud, click the Upload button at 
the bottom right of the dialog. 

− Jobs: To add a new job entry, click the Add button then name the job, assign the job to the primary user 
and then select additional users who will have access to the job in the Permissions area.  Assign the job 
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to a group from the Group drop-down menu at the bottom of the dialog and then click OK to add the 
new job entry.  New job groups can be added by clicking the Groups button at the bottom of the setup 
dialog.  Once a job entry is made, that job can be uploaded or downloaded from the cloud via the portal 
dialog (see Cloud Portal section below).  To move a single job and all associated files from Active to 
Archive, click on the appropriate job file to select it then click the To Archive button.  To move multiple 
jobs and all associated files from Active to Archive, click the Archive Batch button.  To move a job and all 
associated files from Archive back to Active, click the From Archive button, click on the appropriate job 
to select it then click the Extract button. 

− Lists: To add a new list entry, click the Add button then name the list, assign the list to the primary user 
and then select additional users who will have access to the list in the Users area.  To create a new list in 
the cloud from scratch, click the Data button, set the column and row count, add the column names and 
then click the OK button to add the empty list.  To access a list to add or modify data, click on the list 
name to select it then click the Data button.  To create a cloud list by uploading a CSV file, click the 
Upload button, navigate to and select the appropriate CSV file.  To download a list from the cloud to a 
CSV file, click the Download button.  Once lists are created in the cloud, they can be connected to the 
local computer by creating a new external list, set the TradeTek Cloud radio button then click the Select 
button to choose the appropriate list to connect to. 

− Budgets: To add a new budget entry, select the job that the budget is associated with from the Job 
drop-down menu then click the Add button and name the budget, assign the list to the primary user and 
then select additional users who will have access to the budget in the Users area.  To edit a budgets 
name or user information, click on the budget to select it, then click the Edit button.  To delete a budget, 
click on the budget to select it, then click the Delete button.  To add or edit line items in a budget, click 
on the budget name to select it, then click the Data button.  Click into the appropriate cell to make 
changes to the data within that cell.  To add a new row to the budget, click the Add Row button.  To 
recalculate the budget once new numerical data has been entered, click the Calculate button.  To export 
the budget to a report file, click the Report button then set the parameters in the presented dialog.  To 
build a new budget by importing mapped columns of data from a report, click the Build button.  To 
export selected columns from the budget to a CSV file, click the Custom CSV button.  Prior to using the 
Build or Custom CSV buttons, you must set up column mapping from the Cloud Setup dialog.  To set up 
column mapping from the Cloud Setup dialog, click the Setup button.  Choose how many custom 
leading and trailing columns that you would like to add to the budget then click the Column Map 
button.  From the Budget Column Map dialog, you can map columns of data into the budget from a 
report by selecting the appropriate report column number under Report Import Column.  You can also 
map columns of data from the budget to the Custom CSV Export file by selecting the appropriate budget 
column number under Custom CSV Export Column. 

− Invoices: To add a new invoice entry, select the job that the invoice is associated with from the Job 
drop-down menu then click the Add button and name the invoice, assign the list to the primary user and 
then select additional users who will have access to the invoice in the Users area.  To edit an invoice’s 
name or user information, click on the invoice to select it, then click the Edit button.  To delete an 
invoice, click on the invoice to select it, then click the Delete button.  To add or edit line items in an 
invoice, click on the invoice name to select it, then click the Data button.  Click into the appropriate cell 
to make changes to the data within that cell.  To add a new row to the invoice, click the Add Row 
button.  To recalculate the invoice once new numerical data has been entered, click the Calculate 
button.  To export the invoice to a report file, click the Report button then set the parameters in the 
presented dialog.  To build a new invoice by importing mapped columns of data from a report, click the 
Build button.  To export selected columns from the invoice to a CSV file, click the Custom CSV button.  
Prior to using the Build or Custom CSV buttons, you must set up column mapping from the Cloud Setup 
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dialog.  To set up column mapping from the Cloud Setup dialog, click the Setup button.  Choose how 
many custom leading and trailing columns that you would like to add to the invoice then click the 
Column Map button.  From the Invoice Column Map dialog, you can map columns of data into the 
invoice from a report by selecting the appropriate report column number under Report Import Column.  
You can also map columns of data from the budget to the Custom CSV Export file by selecting the 
appropriate budget column number under Custom CSV Export Column. 

− Contacts: The Contacts tab is a place where company contacts can be stored in the cloud for all users to 
access.  Groups can be created to store contacts in.  To create a contract group, click the Groups button, 
click into the first available cell and type the new group name.  To create a new contact, click the Add 
button, fill in the appropriate contact information, assign the primary and other users and select the 
appropriate group for the contact to be placed in from the Group drop-down menu.  To clone a contact, 
click the Clone button and then update the first and last name so that those values are unique then 
make any other appropriate changes and click the OK button to add the new contact.  To edit an existing 
contact, click on the contact to select it then click the Edit button.  To delete an existing contact, click on 
the contact to select it, then click the Delete button.  Contacts can also be used to optionally be 
displayed on invoices. 

− Messages: From the Messages tab, the admin can post messages that are visible to all users who have 
been designated from the Cloud Portal dialog.  To add a new message, click the Add button then type 
the desired message, then click the OK button to add the new message.  To edit an existing message, 
click on the message to select it, then click the Edit button.  To delete an existing message, click on the 
message to select it, then click the Delete button. 

− Logs: From the Logs tab, the admin can view a list of all cloud user activities.  Each log entry includes the 
date that the action was taken, the username and a description of the action.  The previous 10,000 logs 
are retained in the Logs tab. 

Cloud Portal: To access the TradeTek Cloud Portal dialog, click the Cloud button at the top of the application 
window to the right of the main tabs.  The cloud portal dialog is where all standard users (other than the admin) 
will access the cloud.  The portal dialog allows users (based on their permissions set by the admin) to create, 
download and upload preference bundles, create and manage job files, manage database lists, manage budgets, 
manage invoices, manage company contacts, post and view messages and manage job specific and other 
general files.  The Cloud Portal dialog contains the following tabs: 

− Messages: View, add, edit or delete messages. 
− Preferences: Create a new preference bundle by clicking the Custom button. Upload or download 

preference bundles to and from the cloud by clicking the To Cloud and From Cloud buttons. 
− Jobs: Cloud jobs are stored in groups which are created by the admin.  Prior to performing any cloud job 

related tasks, be sure to select the appropriate job group from the Group drop-down menu.  To add a 
new job entry to the cloud from a locally created job click the Add button, select the appropriate job 
name from the list and click OK to create the new cloud entry.  To edit an existing cloud job, click on the 
job name to select it then click the Edit button.  To create a new local job from a cloud entry job name, 
click on the appropriate job name to select it then click the New Job button.  To delete the selected job, 
click the Delete button.  To upload the entire job file of the selected job from the local computer to the 
cloud for the first time, click the Upload button.  To download the entire job file of the selected job from 
the cloud to the local computer for the first time, click the Download button.  To reserve a cloud job 
that you are currently working on so that other users cannot access it, click the Reserve button.  To 
release a selected cloud job that is currently reserved, click the Release button.  To sync job data from a 
local job to the cloud (that has previously been uploaded) click the job name to select it then click the To 
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Cloud button.  To sync job data from the cloud to a local job (that has previously been downloaded) click 
the job name to select it then click the From Cloud button. 

− Lists: To upload a list to the cloud via CSV file, click the Upload button.  To download a list from the 
cloud to the local computer, click the Download button.  To edit a cloud list, click on the list to select it, 
then click the Data button.  List groups can be set up and used to toggle between location-based sets of 
lists.  From the TradeTek Cloud Setup dialog, click the Groups button.  Click the Add button to add a 
new location group.  Once a group is added, click on the group name to select it then click the Add Map 
button.  Enter the virtual list name that will be connected to the external list created in the List tab, then 
select the actual location-based list to be mapped to it.  A list map must be set up for each of the main 
lists in the group.  The virtual list names MUST be the same in each added list group.  Once all list groups 
are set up, create each new external list in the List tab that will be connected to each group virtual list.  
Click the Add List button, set the External radio button, set the TradeTek Cloud radio button, click the 
List Name button then select the virtual list to connect the new external list to.  Once all of the lists are 
created and connected in the List tab, to toggle the lists between groups click the Select Group button 
located in the Update button group in the List tab. 

− Contacts: Select the appropriate contact group from the group drop-down menu to display the contacts 
within that group.  To edit a contact, click on it to select it then click the Edit button.  To delete a 
contact, click the Delete button.  To view a contact, click the View button. 

− Budgets: To upload a budget from the local computer to the cloud, click the Upload button.  To 
download a budget from the cloud to the local computer, click the Download button.  To add or edit line 
items in a budget, click on the budget name to select it, then click the Data button.  Click into the 
appropriate cell to make changes to the data within that cell.  To add a new row to the budget, click the 
Add Row button.  To recalculate the budget once new numerical data has been entered, click the 
Calculate button.  To export the budget to a report file, click the Report button then set the parameters 
in the presented dialog.  To build a new budget by importing mapped columns of data from a report, 
click the Build button.  To export selected columns from the budget to a CSV file, click the Custom CSV 
button.  Prior to using the Build or Custom CSV buttons, the admin must set up column mapping from 
the Cloud Setup dialog.  To edit the notes field of a budget in the Cloud Portal dialog, click the Notes 
button.  To delete the selected budget, click the Delete button.  To email a budget directly from 
TradeTek, click the Send button.  The admin must set up the email account information from the 
Settings tab in the Cloud Setup dialog to be able to use the Send button. 

− Invoices: To upload an invoice from the local computer to the cloud, click the Upload button.  To 
download an invoice from the cloud to the local computer, click the Download button.  To add or edit 
line items in an invoice, click on the invoice name to select it, then click the Data button.  Click into the 
appropriate cell to make changes to the data within that cell.  To add a new row to the invoice, click the 
Add Row button.  To recalculate the invoice once new numerical data has been entered, click the 
Calculate button.  To export the invoice to a report file, click the Report button then set the parameters 
in the presented dialog.  To build a new invoice by importing mapped columns of data from a report, 
click the Build button.  To export selected columns from the invoice to a CSV file, click the Custom CSV 
button.  Prior to using the Build or Custom CSV buttons, the admin must set up column mapping from 
the Cloud Setup dialog.  To edit the notes field of an invoice in the Cloud Portal dialog, click the Notes 
button.  To delete the selected invoice, click the Delete button.  To email an invoice directly from 
TradeTek, click the Send button.  The admin must set up the email account information from the 
Settings tab in the Cloud Setup dialog to be able to use the Send button. 

− General: This tab is an area to store general files that are not associated with a specific job. 
− PDF’s, JPG’s, CSV’s, Excel: These tabs are used to store each file type that is associated with a specific 

job.  Use the Job drop-down menu to view the files associated with the selected job. 
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− Files: This tab is used to store any other file type that is associated with a specific job.  Use the Job drop-
down menu to view the files associated with the selected job. 

TradeTek Shared 

Shared License Management:  
 
Follow this process to set up TradeTek Shared license on the Main and Second computer: 
 
1. Purchase TradeTek Shared and receive TradeTek Shared Serial Number by email. 
2. Launch TradeTek previously installed on Main computer. 
3. Click TradeTek Shared button in the Preferences dialog and enter TradeTek Shared Serial Number. 
4. Set Shared License checkbox to generate private Cloud space and then click Done. 
5. Download and install TradeTek Shared on Second computer. 
6. Launch and activate using TradeTek Shared Serial Number on Second computer 
 
Move TradeTek Shared License to New Second Computer: 
 
The user installs the TradeTek Shared License on their Laptop or Home computer and activates it with the 
Shared Serial Number.  The user can Release/Restore the Shared License from the Second computer if they buy 
a new machine.   
 
Plugins are not part of the Shared License experience.  Plugins contain executables, may depend on other 
applications or services on the computer, are relatively large and may use developer specific licensing features 
outside of the scope of TradeTek.  If desired, a Plugin could be installed and licensed independently on the 
Second computer. 
 
The process of installing, activating, managing or building Bundles is always done on the Main computer. 
 
Move TradeTek Shared License to New Main Computer: 
 
Normally when a TradeTek Shared license is removed from the Main computer, the cloud account and all 
preference and job data in the cloud is cleared.  This process details how to decommission an old Main 
computer and retain the TradeTek Shared data in the cloud when moving TradeTek to a new Main computer. 
 
1. Make sure the new Main computer is NOT connected to any TradeTek Shared account. 
2. Make sure the old Main computer and Second computer is NOT running TradeTek. 
3. Start TradeTek on the new Main computer and present the Preferences dialog. 
4. Click the TradeTek Shared button and enter the TradeTek Shared Serial Number. 
5. Click the Shared License checkbox, then click OK to close the TradeTek Shared Setup dialog. 
6. Open the TradeTek Shared Setup dialog again from the new Main computer and all jobs should now be 
visible. 
 
Switching between Main and Second Computer: 
 
By design, the Main and Second computer should never run TradeTek at the same time.  After the initial setup, 
preferences should be the same on Main and Second computer.  The TradeTek Shared Setup dialog is only 
available from the Main computer and is generally not used again for daily operations. 
 
For daily use, the Shared button on the Home panel presents the TradeTek Shared Portal dialog.  Jobs are 
stored in Local storage on the main and second computer.  A job is initially created on one computer, uploaded 
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to the cloud and then downloaded to the other computer.  Thereafter the fast To Cloud and From Cloud buttons 
are used in the TradeTek Shared Portal dialog.   
 
When completing work on a computer, if you plan to use the preferences and jobs on the other computer, 
remember to sync the preferences and jobs to the cloud with the To Cloud buttons.  From the other computer, 
use the From Cloud buttons to update the Preferences and Jobs before doing additional work. 
 
If TradeTek is running on the Main computer, TradeTek cannot be opened on the Second computer.  If TradeTek 
is running on the Second computer, TradeTek should generally not be used on the Main computer.  As a failsafe, 
TradeTek allows the user to optionally run TradeTek on the Main computer even if it detects that it was left 
running on the Second computer, but the user gives up the ability to save any unsaved changes from the Second 
computer. 
 
Shared Setup: To access the TradeTek Shared Setup dialog, click File at the top left, click Preference then click 
the TradeTek Shared button.  To delete your shared account and all associated cloud data, click the Delete 
Account button at the top right corner of the dialog.   

In the Preferences tab, click the Backup button to upload a backup of your entire preference file from the local 
computer to the cloud.  Once a backup has been completed, click the Restore button to restore the preferences 
on the local computer from the cloud backup.   

The Jobs tab is where shared jobs are managed.  To upload a job from the local computer to the cloud, click the 
Upload button then select the appropriate job file.  To download a job file from the cloud to the local computer, 
click on the job name to select it, then click the Download button.  To delete a cloud job, click on the job name 
to select it, then click the Delete button.  To sync changes from a cloud job to the job on the local computer, 
click the From Cloud button.  To sync changes from a job on the local computer to the cloud, click the To Cloud 
button. 

Shared Portal: To access the TradeTek Shared Portal dialog, click the Shared button to the right of the main tabs 
across the top.  To sync preferences from the cloud to the local computer, click the From Cloud button.  To sync 
preferences from the local computer to the cloud, click the To Cloud button.  To sync job data from the cloud to 
the local computer, click the From Cloud button and select the appropriate cloud job file.  Once the appropriate 
job is opened in TradeTek, to sync job data from the local computer to the cloud, click the To Cloud button. 

AI Assistant  

To launch AI Assistant, click the AI button located to the right of the main tabs at the top of the application 
window.  Set the appropriate radio button at the left side of the dialog for the knowledge source that you wish 
to ask a question about.  Once the appropriate knowledge source radio button has been selected, type your 
question into the Question input then click the Ask AI button at the top right corner of the dialog.  The answer 
will be returned from the AI engine and will be displayed in the Answer area.  To clear the Answer area, click the 
Clear Conversation button.  To save the conversation by exporting a text file to your desktop, click the Save 
Conversation button. 

Advanced: Set the Advanced checkbox to enable the advanced features in the AI Assistant dialog.  When 
activated, the additional knowledgebases that are available in the Enhanced account become visible to select 
from when asking a question.  You can also select a Question Prefix to be automatically included in front of your 
question.  See additional information below related to question prefixes.  In the Response Related to Job Pages 
area, when a question is asked about multiple pages, set the appropriate radio button to choose to have a 
separate response for each page or a consolidated response. 
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Settings: Click the Settings button to launch the AI Settings dialog.  Set the appropriate radio button at the top 
left corner to toggle between AI engines.  All TradeTek with Cloud accounts come with Basic level AI service, 
which allows you to use all available AI engines and ask a throttled number of questions per day.  With the Basic 
service you can ask general chat questions, questions about pages in the currently opened job or images in the 
clipboard or on disk and questions about TradeTek (the TradeTek knowledge base comes pre-loaded).  Enhanced 
AI service significantly increases the number of allowed questions per user per day, as well as allowing the user 
to upload their own job specific knowledge base via pdf file(s) and any other general knowledge base pdf file(s).  
Contact your Sales Representative to upgrade your AI account from Basic to Enhanced.  To use AI to power Auto 
Page Name instead of the default OCR technology, set the Use for Auto Page Name checkbox.  Switch between 
available AI Engine models by selecting from the Model drop-down menu.  In the Questions tab, recently asked 
questions are listed below Recent Questions.  Click the Add to Favorites button to add a question from Recent 
Questions to the Favorite Questions area.  To manually add a question to the Favorite Questions area, click the 
Add button.  Questions in the Favorite Questions area are available in the Question drop-down menu in the AI 
Assistant dialog.  When the Preload Images for AI Assistant checkbox is checked, all the pages in the currently 
opened job will be uploaded to the server as soon as the AI Assistant dialog is launched.  When questions are 
asked related to pages, this will make the response time a little faster. 

When AI settings have been customized by the user, click the Export button at the bottom left corner of the AI 
Settings dialog to export an AI settings file that can be imported by other computers.  

Knowledgebases: The Knowledge tab is only accessible from an Enhanced AI account.  When the TradeTek 
radio button is selected, the preloaded knowledgebase file names are displayed.  To upload a job specific pdf 
knowledgebase file, select the Job radio button, add an optional name for the file then click the Add button.  
Use the additional Custom radio buttons to add supplemental knowledgebase pdf files.  Click the Clear All 
Knowledge Files button to delete all currently listed files. 

Question Prefixes: Question prefixes can help determine the way that AI answers your questions.  Sometimes 
it’s helpful to include a prefix in front of your question to help get the type of results that you want.  The prefixes 
listed in the Question Prefix tab are selectable in the AI Assistant dialog when the Advanced checkbox is 
checked.  Some common prefixes are preloaded with additional space for a user added prefix.  All prefixes can 
be modified by the user here. 
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